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1. Introduction 

1.1 Overview 

This document is the Release Notes for Cormant-CS with version numbers starting 

with 12. It describes the changes from previous releases of Cormant-CS, new 

feature overviews and, if applicable, any information to upgrade.   

 

Please see the root level folder in the software release package for prior version 

release notes. If you are upgrading from a version of Cormant-CS prior to 11.3, we 

strongly suggest you read the previous release notes as this document only refer to 

version 12 and assumes you are familiar with all changes up-to and including 

version 11.3. 

 

This introduction is a summary of each release, see each major section for full 

details about each release.  

 

Installation of the latest release will also supply all prior version changes.  

 

1.2 Operating System, SQL and Browser Support 

Cormant-CS supports all versions of Microsoft Server from 2016, onwards. Server 

2012 support is not available.   

Cormant-CS supports all versions of Microsoft SQL from 2016, onwards.  

Browser support includes the latest versions of Edge, Chrome, Firefox, Safari on 

PC, Apple, Linux, Android & iOS mobile devices. 

The Android offline application supports Android 9 and above. 

The Windows offline application supports Windows 10 and above. 

1.2.1 Support ending 

During Q3/Q4 2022, Cormant dropped support for Microsoft SQL 2012 and 2014. 

SQL 2016 will be the oldest version supported.   

During Q3/Q4 2022, Cormant dropped support for Windows Server 2012. Windows 

Server 2016 will be the oldest version supported.  

In all cases, Cormant supports up to the latest versions released by Microsoft, 

including all patches and SP versions.  

1.3 Reference Documents for Cormant-CS Version 12 

As part of the release of software there is a documentation folder. This folder 

contains a number of key documents: 

• Cormant-CS Installation Guide.pdf – provides full new and upgrade 

installation instructions.  

• Multiple files: Cormant-CS 12.X New Features Training.pdf – provides a 

detailed review of Cormant-CS 12 new functionality for each release. 

• Cormant-CS-Offline-Sync-Service-Guide.pdf – setting up 

synchronization to Offline Android.  

• Cormant-CS-Offline-Manual.pdf – using the Cormant-CS Offline 

application.  

We highly recommend these documents are reviewed prior to upgrade.  
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1.4 Offline Compatibility with Cormant-CS 12.3.2 

If your organization uses the Offline application (Android and Windows), please 

note key changes include: 

• Android and Windows Offline applications with versions prior to 12.3.0 will 

not work with Cormant-CS 12.3.2. 

• The Android and Windows Offline Application with version 12.3.0 will work 

with this version of Cormant-CS - 12.3.2. 

So, if you are using Android or Windows devices with the Cormant-CS Offline 

Application, all data needs to be synced to Cormant-CS and the Offline Application 

upgraded to 12.3.0 or later, at the same time the Cormant-CS server is upgraded.  

As of version 12.3.0 the ports used internally (within the machine) by the Offline 

Application have changed. 8081 is now 54987 and 8082 is 54986. The Offline 

Application is made up of three parts a User Interface – Business Tier – Database, 

the UI and Business Tier uses the ports to communicate. There is no external 

access needed to these ports.  

1.5 Licensing - Upgrading from a Version prior to 11 (New 

Key required) 

An internal change in licensing for version 11 on requires a new license key to 

install Cormant-CS version 11+. Please email Cormant-Finance@bgis.com for a 

new key, if one has not already been provided to your key contact.  

1.6 Cormant-EDIS Compatibility 

This version of Cormant-CS is compatible with the following versions of Cormant-

EDIS (this interface solution to systems such as ServiceNow, Jira, and others).  

• 2.10.0 

1.7 Deprecated API Endpoints 

1.7.1 SOAP API 

Some endpoints are now deprecated. This is because they return templates or 

attributes that will not be of the correct Component context, or the context is not 

clear by the name and may be misleading in the future. Another potential issue is 

attributes with the same name. When developers search for an attribute by name 

the first matching attribute irrespective of context will be returned. The new 

endpoints only return Component context attributes. 

The GetAllAttributes endpoint has not been deprecated and will continue to return 

all attributes. A new property has been added to the returned data about an 

attribute (AttributeGroupContextType) that identifies the attribute’s context, so 

that developers can sort and identify the attribute required. 

 

Other Reasons for deprecating endpoints are Endpoints are being replaced to 

support new features. The old endpoints are not changed so as not to break 

existing code that may have been written. 

 

The Reports Endpoints have not worked for a long time and we are not aware of 

any customers who use them. 

 

mailto:Cormant-Finance@bgis.com
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1.7.2 The deprecated endpoints with replacements are: 

Deprecated Endpoint Date 

Deprecated 

Replacement Endpoint Endpoint removal 

GetAllTemplates September 22 GetComponentTemplates Cormant-CS 13 

GetAllTemplatesTemplate September 22 GetComponentRootTemplate Cormant-CS 13 

GetTemplatesByLevel September 22 GetComponentTemplatesByLevel Cormant-CS 13 

GetAttributeByName January 23 GetCompontAttributeByName Cormant-CS 13 

GetAttributeSelections 

ByName 

January 23 GetComponentAttributeSelections 

ByName 

Cormant-CS 13 

GetPredefinedAttributes January 23 GetComponentPredefinedAttributes Cormant-CS 13 

GetSnmpPropertyValue 

ByComponentIDAndProp 

erty 

May 2023 GetSnmpScalarTabularV 

alueByComponentIDAndProperty 

Cormant-CS 13 

GetSnmpPropertyValue 

ByComponentIDPropert 

yAndIndex 

May 2023 GetSnmpTabularCellVal 

ueByComponentIDAndProperty 

Cormant-CS 13 

GetSnmpPropertyValue 

ByComponentPropertyA 

ndIndex 

May 2023 GetSnmpTabularCellVal 

ueByComponentAndProperty 

Cormant-CS 13 

GetUserReport June 2023  Cormant-CS 13 

GetUserReportsByUser June 2023  Cormant-CS 13 

GetHistoricalUserRep 

ortByUser 

June 2023  Cormant-CS 13 

GetCustomUserReportB 

yUser 

June 2023  Cormant-CS 13 

DeleteUserReport June 2023  Cormant-CS 13 

SaveUserReport June 2023  Cormant-CS 13 

SaveComponent July 2023 SaveComponentAttributes or 

TryUpdateComponentAtt 

ributeValue 

 

GetReportFolderByNam 

e 

Mar 2024 GetCustomReportFolder 

ByName 

Cormant-CS 13 

GetReportFolderByID  Mar 2024 GetCustomReportFolder 

ByID 

Cormant-CS 13 

GetAllReportsByReport  Mar 2024 GetAllCustomReportsBy Cormant-CS 13 

GetReportAttributes  

 

Mar 2024 GetCustomReportAttrib 

utes 

Cormant-CS 13 

GetAllReportFolders  

 

Mar 2024 GetAllCustomReportFol 

ders 

Cormant-CS 13 
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1.8 Release 12.3.2 

This Release adds the ability to Select a global store that gets added to all Sync 

Profiles and a single bug.  

Admins can now configure a Global Store where new equipment and cables can be 

added. This store will then be added to all Sync Profiles and allow users to scan the 

barcodes of the new equipment or cables. 

An issue with “Playing Forward” connections that use existing barcoded cables was 

discovered while testing for the Global Store feature. When “playing forward” new 

connections, this bug, creates a new cable with the same name but no Barcode as 

the original. This bug affects all prior versions of the offline application.  

1.9 Release 12.3.1 

This is a single bug Release.  

A Plan View refresh issue was corrected. 

1.10 Release 12.3.0 

This is a feature improvement release which also addresses a large number of 

reported and unreported bugs.  

Customers with several instances of Cormant-CS for Production and UAT Purposes 

are now able to add text and change the top banner color to easily differentiate 

between these instances. The configuration remains between re-installation of the 

application and database upgrade from another system. So perfect for UAT / Test 

instances which are periodically updated with a copy of the production systems 

database. 

Password length (max 32 char) can now be specified independently from password 

strength. 

Additional logs have been add to track who and what data has been exported from 

the system, and changes to Plan Views. 

Additional Role Permissions are available along with the ability to report on the 

permissions set. 

A new library (IronPDF) is now being used to produce PDF’s. This has been 

prompted by potential security and license issues with the old one. This means that 

customers may notice that the Release Package is larger than before. The 

application also takes up more space on disk.  

Audit module has been added to Offline Cormant-CS App. Both Equipment Audits 

and Connection Audits can be done. The items audited and other changes made as 

part of the Audit process can be synced to the main database. 

Important 

As part of this work the Offline Sync Service has had an update that prevents it 

working with Offline Applications prior to 12.3.0. This means that all Offline Devices 

will need to be synchronized with Cormant-CS prior to Upgrade of the Server. See 

1.4 above 

1.11 Release 12.2.1 

Bug fix release with one fix for using HTTPS to connect to the Entra ID server.  
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1.12 Release 12.2.0 

The IIS’s “csweb” Application Pool now uses the “Integrated” model rather than 

“Classic”. This is to support features such as SignalR that communicates process 

progress information. This change should happen automatically as part of the re-

installation of Cormant-CS Web.  

This release enables customers who use Entra ID (Azure AD) to use that 

Authenticator Application to use Cormant-CS. The Authenticator (Cormant-CS, 

LDAP/AD, Entra ID) that a particular user is to use can be configured on a user by 

user basis. 

Configuration of LDAP/AD and Entra ID now part of Application and stored in the 

Database. This data is no longer to be entered into the web.config file as part of 

the application installation process. 

There are UI improvements allowing users to see a more accurate process progress 

for actions such as Import and Delete of components. 

The Date Pickers that a user will use to set Dates and Date Times will be that 

provided by the Browser being used. 

Historical Reports can now be placed in Folders. Copying, Moving, and Deleting of 

both Custom and Historical Reports can be done by drag and drop, Cut/Copy/Paste 

and Keyboard shortcuts. 

A Windows version of the Offline App has been created and is available in the 

release folder alongside the Android version. 

See the Below for full details. 

1.13 Release 12.1.0 

This version enables customers who use Cormant-CS login accounts to access 

Cormant-CS to configure and use Email base Two Factor Authentication (2FA) 

A lot of minor but annoying UI bugs have been sorted out. Along with further speed 

improvements. 

See the Below for full details 

1.14 Release 12.0.1 

This version contains a fix for a bug that prevents the Database Wizard from 

upgrading customer databases that were first created prior to Version 8.0. 

Important 

As part of this work the Android Offline Sync Service has had an update that 

prevents it working with Android Offline Applications prior to 12.0.1. This means 

that all Android Devices will need to be synchronized with Cormant-CS prior to 

Upgrade of the Server. See 1.4 above. 

1.15 Release 12.0.0 

Initial release, see reference documents. 
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2. Installation 
The Cormant-CS Installation Guide in the Documentation folder of the release 

contains details about installation process.   

2.1 Upgrade from Cormant-CS 7, 8, 9, 10, 11 to version 12 

There are no differences to the distribution requirements for Cormant-CS version 

12 vis-a-viz Cormant-CS 7, 8, 9, 10, 11. The upgrade will be similar to any normal 

upgrade: 

• Sync all Handheld Devices (if using). 

• Backup the existing Cormant-CS database.  

• Uninstall Cormant-CS Client (pre-10), Server and Web.  

• Use the Setup_x64.exe in the Server folder (Full Installers) of the release. 

An MSI installer is provided for use by customer performing an in-major-

version-upgrade, but the exe should be used for first upgrade to 12.x. 

• Run the Database Wizard, it should start automatically. This ensures that 

the configuration points to the correct database instance and will update the 

schema and create new stored procedures.  

• Install the Cormant-CS web using the .exe file. The same rules regarding 

MSI installers apply.  
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3. User Configurable Database 

Stored Procedures 
The Cormant-CS database has a number of Stored Procedures that are designed to 

be configured to suit particular customer requirements. These Stored Procedures 

are not automatically updated as part of the database upgrade process and, if 

required, updates need to be done by customers. 

There are three types of Stored Procedure that falls into this category: 

3.1.1 Asset Export Reports 

These are the exports that users can output via the Asset Tree’s Context Menu’s 

Exports options: 

• Affected Devices 

• Free Cables Export 

• Power Affected Devices 

• History Export - this no longer works and can be removed. It has been replaced by the 
History tab which provides better functionality. Contact Support for how to remove 
this export! 

• Rack Connections Report 

Note: Your site may not have or have additional export reports to the ones listed 

above. 

There are currently no recommended updates to any of these stored procedures.  

3.2 Workflow 

If customers are not using the Workflow module then there is no need to update 

either the Export to Excel or the Workflow Validation Stored Procedures.  

 

If you or your users are looking to experiment with Workflow we highly 

recommend reading the “Simple Workflow Setup Read Me” document in the 

release folder under “.\Implementation Tools and Examples\Simple Workflow 

setup”. Here you will find details of how to set up workflow to try it out in your 

environment. This directory also holds an example “Update Task Validator” stored 

procedure which is a good starting point for most customers. 

3.2.1 Workflow’s Export to Excel Feature: 

• Affected Devices 

• Patch Schedule Report 

• Power Affected Devices 

• Rack Selector Scores 

• Task Summary Report 

Note: Your site may not have or have additional export reports to the ones listed 

above. 

3.2.2 Workflow Validation Procedures 

• Create Order Validator 

• Update Order Validator 

• Create Task Validator 
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• Update Task Validator 

See the current Version release details for specific information regarding any 

changes made to any of these Stored procedures and any special upgrade 

information. 
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4. Changes in 12.3.2 

4.1 Optional Global Store can be added to All Sync Profiles. 

Admins can now configure a Global Store space where new equipment and cables 

can be added. This store will then be added to all Sync Profiles and allow users to 

scan the barcodes of the new equipment or cables. 

In the Android Offline Sync Service’s Settings.config file a new configuration setting 

has been added “Global_Store_Component-ID” if a valid component ID for a Space 

(preferably of type Store Room) is entered, This space will be added to every sync 

Profile. All components in this global Store will then be “visible” and when scanned 

will be found and used for installation and connection activities.  

5. Changes in 12.3.0 
This version has changes to: How users are identified when logging on. Progress 

notification of potentially long running tasks has been improved. New Chart types 

have been added to the dashboard, and a new Offline App for Windows mobile 

devices has been released. 

5.1 New Attribute Types and Properties have been added. 

Unique – A property that checks existing values when updating the attribute and 

flags an error if a duplicate would be created. This property is only available for 

Alpha and Alphanumeric attribute types. When copying components the attributes 

marked as unique will be cleared. On the Search Results grid the Column Header 

edit capabilities that allow all rows to be set to the same value are disabled. 

The following Attribute Types have been added: 

IP Address – Restricts values to valid IP Addresses. Both IP4 and IP6 are 

allowed. 

MAC Address – Restricts values to valid MAC Address formats. 

DateTime – allows a time portion to be stored along with the date. 

5.2 User Management Improvements. 

The Users tab has been made the initial landing page when entering the module. 

The Zones tab’s All Spaces area has been simplified to make it clearer.  

The arrangement of the Permissions tab has been improved and expanded. 

Permissions can be set for Historical and Scheduled report folders. The Alerts 

module access can now be set / restricted. A Section has been added to control a 

Role’s ability to Export data from various parts of the system. 

When creating a new Role, the user can clone attribute and report folder 

permissions from another Role and the Zone permissions from a different Role. 

There is a new tab: Permission Reports which allows the Administrator to see and 

report/export the permissions for different parts of the permissions system.  

The length of passwords used for Cormant-CS controlled logins can now be set 

independently of the password strength. 
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5.3 Search Results tab improvements. 

The user can select filtered items in the Search Results tab and using the new 

Actions button’s Link to Album option can select and assign an Album to those 

rows. 

The user can select filtered items in the Search Results tab and using the new 

Actions button’s Create Tasks option can create Workflow tasks for those rows. 

5.4 Workflow changes 

Users no longer need to specify the new name of a component when creating a 

Rename task. When installing an existing component that will require a name 

change, the component is not immediately renamed as previously. Instead, the 

user can decide when the component is renamed using the Rename button. 

Users can create a new Order from the Create Task dialog if it is found that the one 

desired has not been created yet. 

The Create Task dialog’s “Customer Questions” section now supports Mandatory 

Attributes and will cause validation when saving the task if these are not filled out. 

5.5 Alerts Module. 

The Alerts Modules: Enable Alerts and Thresholds tabs have been moved to the 

Admin > Configuration section. 

5.6 Reports Module. 

The way Scheduled reports are defined has been changed. The settings that affect 

when and where the reports are going to is defined in a new tab: Details. A new 

tab Asset Reports is where the user can define what the report is, that they wish to 

schedule.  

More than one email address can be assigned to be the recipient of a Scheduled 

report. 

Scheduled Reports can be arranged in folders. 

All report types can now be Copied, Cut and Pasted from one folder to another 

folder in the same report section. Users can also use keyboard short cuts and Drag 

and Drop. 

5.7 Component Imports. 

Component Imports now support the use of Component ID. This is the unique 

internal identifier for the component. When specified the only other details that 

need to be added is the data that is to change. So, no need to specify Name or 

Space. 

The Component ID can be found by placing the mouse cursor over the Name and 

Space fields in the Assets > Details tab and viewing the tool tip. 

The Component ID is now part of Component Export and can be added to Reports 

5.8 Templates. 

Template settings for Scripts and Thresholds can be cloned to other Templates.  

On Admin>Templates>Attributes tab attributes now show their Units. 
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5.9 Plan View. 

Speed of Plan View has been improved, with the addition of caching and only 

sending / receiving the changes to the plan.  

The export of an image (PNG, JPEG, BMP) of a Plan View can be done via the new 

Export button. 

Changes to spaces and components on plans are now logged to Component History 

as source Plan View 

5.10 New Layout for DB Tools. 

The DB Tools tab has a new layout making it easier and more intuitive as to what is 

happening. 

5.11 Configuration to allow differentiation between Cormant-

CS Instances. 

Many Customers have Several instances of Cormant-CS for Production and UAT 

Purposes. Customers are now able to add text and change the top banner color to 

easily differentiate between these instances. The configuration remains between re-

installation of the application and database upgrade from another system. So 

perfect for UAT / Test instances which are periodically updated with a copy of the 

production systems database. 

5.12 Export logs. 

When exporting data from the system, logs are created to track who and what was 

being exported. These logs can be viewed in Admin > Logs > Export Log, with the 

usual filtering options. 

5.13 General Improvements. 

The speed at which Rack Views display has been improved. 

The way reports are processed and the amount of memory they consume has been 

improved. 

On the Saved Attributes page the user can now see when the attributes were last 

saved. 

5.14 Offline Cormant-CS App. 

Audit has been added to Offline Cormant-CS App. Both Equipment Audits and 

Connection Audits can be done. The items audited and other changes made as part 

of the Audit process can be synced to the main database. 

The Administrator can now select what Spaces are included as part of a Sync 

Profile.  

The Offline app now allows Users to download more than one Sync Profile onto an 

offline device for use later. The user selects which profile, from the ones 

downloaded, that they wish to work on when signing in to the application. 

Important 

As part of this work the Offline Sync Service has had an update that prevents it 

working with Offline Applications prior to 12.3.0. This means that all Offline Devices 

will need to be synchronized with Cormant-CS prior to Upgrade of the Server. See 

1.4 above 
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6. Changes in 12.2.0 
This version has changes to: How users are identified when logging on. Progress 

notification of potentially long running tasks has been improved. New Chart types 

have been added to the dashboard, and a new Offline App for Windows mobile 

devices has been released. 

 

6.1 Enhanced Identification Process. 

Users can now be configured to use Cormant-CS, LDAP / Windows Active Directory 

(AD) or Entra ID (formerly Azure AD) as the identity provider to confirm login 

details. This means that different users can be set to use their Active Directory 

account name and password to login while other users their Cormant-CS and 

Cormant Password. Entra ID has been added to the list of allowed Identity 

Providers. Customers with WWW exposed instances of the software have requested 

this to provide a more secure web friendly logging in process for their web users. 

Entra ID supports MFA and Single Sign-On capabilities.  

 

 

 

Note: If you use IIS’s Windows Authentication you will not be able to take 

advantage of these improvements and IIS handles the Identification process. 

6.2 LDAP / Active Directory Configuration Moved to User 

Interface. 

LDAP / Active Directory configuration is no longer done in the web.config file. A 

new Tab has been added Admin > User Management > Authentication. Here all the 

settings can be entered and these will now be persisted between upgrades. 

Also on the new Authentication tab are the settings for Entra ID configuration.  

 

See the New Installation Guide for detailed instructions for setting up LDAP/AD and 

Entra ID.  
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6.3 Detailed Progress Bars. 

User will now see detailed progress bars for actions like Deleting and Importing 

Components. These show the number of items processed against the total in both 

numerical and visual way. 

 

6.4 New Meter chart types added to Dashboard. 

The choice of chart types for display of Custom Report data has be expanded to 

include meter chart types of Cylinder, Thermometer and Vertical LED charts. 

Configuration is the same as for the existing Meter type chart. 

6.5 Historical Reports Now in Folders. 

We have added the ability to add folders to store your Historical Reports in. This 

will allow you to group reports and make them easier to find. 

You will now see your Historical Reports in a folder called General Folder. You can 

create additional folders and rename the General Folder as required. Historical 
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Reports can be Dragged and Dropped, Cut/Copy/Pasted to move or copy them. You 

can also use keyboard short cuts keyboard short cuts. Historical Reports cannot be 

moved to Custom Report folders and vise versa.  

The name of a report must be unique to a Folder, but other folders can contain 

reports of the same name.  

 

6.6 New Way to Select a Rack in Workflow. 

The Rack Selector Scores export has been a popular and useful tool in workflow 

for a while. We have now made it part of the UI and it can be access via a button – 

Rack Selector Scores. 
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A new Rack Selector Scores dialog will appear with the racks ordered in the 

datacenter by their capacity scores. Racks with more available Space, Power, 

Cooling are at the top, less suitable racks are at the bottom 

The columns can be Sorted by clicking the headers. 

 

If the task is in Edit Mode, a rack can be selected to use for the task by setting the 

check box. 

Hovering over a rack will show the Unit Location Selector and the location you 

want the device be place can be selected and set for the task as well, saving time. 

Click OK to save and return to Workflow 

6.7 The Script Logs Page Can Now Easily Access All Records 

The Admin > Logs > Script Logs tab has been altered so that it is more responsive 

and will work easily with all the log data that is available. 

A Toggle button Updates Auto (default on) causes new logs as they are created to 

be sent to Grid. The Script logs in the DB can be Filtered using the Filter Section. 

The filtered view will be updated with new logs that fit the filter if the toggle is set 

to Updates Auto. 

The Grid columns can be Sorted – toggle changes to Updates Off and if the user 

changes toggle to Updates Auto the grid will revert to sort by Log Time. 

It is easy to search older logs by changing pages, but again the toggle will change 

to Updates Off and if the user changes toggle to Updates Auto the grid will 

revert to the first page. 

6.8 Windows Offline Application. 

A new Windows Offline Application has been created. It looks, works and is 

configured the same as the Android Version. 

Installation is the same as other windows applications – installer is in the Offline 

Application section of the Release package. 

For further details see the Offline Application User Guide and Configuration Guide in 

the Documentation section of the Release package. 
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7. Changes in 12.1.1 
Bug release to fix issue of Object Ref errors in IIS Windows Authentication 

environments. 

8. Changes in 12.1.0 
This version enables customers who use Cormant-CS login accounts to access 

Cormant-CS, to configure and use Email base Two Factor Authentication (2FA) 

8.1 2FA. 

User who log into Cormant-CS and who are authenticated via their Cormant-CS 

Password can be configured to use 2FA via emailed pass code.  

When Users log in to Cormant-CS a 6 digit code will be sent to their registered 

email accounts and this code must be entered into an Authentication Confirmation 

dialog before the user is granted access to the application. Users have the option to 

remember the authentication on the device / browser. 

See 12.1.0 New Features Training.PDF for more information. 

8.2 Connections Import Format enhanced. 

Connections Import file format has been enhanced to more accurately document 

user’s intentions and also make creating connections import files easier. These 

changes mean that dangling cables can be imported. 

See 12.1.0 New Features Training.PDF for more information. 

8.3 Scripting Service Improvements. 

The Scripting Service that runs scripts has be improved to provide better through 

put. This particularly affects SNMP scripts that collect data from devices. To fully 

take advantage of these improvements, customers are advised to make minor 

changes to their scripts to improve multi-tasking. If customers suspect that they 

are using scripts that collect data via SNMP they should contact Cormant Support 

for help and advice on suggested changes for scripts that use SNMP to collect data. 

8.4 SOAP API Improvements. 

The Soap API has been reviewed. 

A lot of endpoints that had developed issues have been fixed. 

Some Endpoints are not going to be supported and have been deprecated and will 

be removed in Cormant-CS 13.0.0 

There were some endpoints that were documented as being for use with cswebapi 

code, was actually designed for use in Cormant-CS Scripts only. The documentation 

of these endpoints has been corrected. 

We have tried to maintain the format of current endpoints. There are some new 

Features and corrections to old features where we have taken the view that rather 

than change existing endpoints and so break existing code using those endpoints. 

New endpoints have been created and the old ones marked as deprecated. This will 

allow customers time to review and plan changes to their code that uses Cormant-

CS SOAP API. 

For full details of all of these changes see the SOAP API Programming Guide. 
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8.5 General Bug fixes and Improvements 

A lot of minor but annoying UI bugs have been sorted out. Along with further speed 

improvements. 

See the  

9. Changes in 12.0.1 
This version resolves an issue with upgrading Cormant-CS databases which were 

first created prior to Cormant-CS 8.0. The Android Offline Application will need to 

be upgraded as part of the upgrade process. See 1.5 above for more details. 

10. Changes in 12.0.0 
This version resolves a number of issues with Android offline synchronization that 

had the potential to leave some data unsynchronized. While this was unlikely, 

customers were advised of these issues once discovered by BGIS Cormant. To 

ensure they will not occur in a live or test environment please ensure Android 

offline software is upgraded to 11.3.4, as well as Cormant-CS core. Google Play 

store is already updated to this version, so it is possible devices may receive this 

version automatically depending on each enterprises policy.  

10.1 Key changes in 12.0.0 

10.1.1 New Feature called Albums 

Albums allow you to group some files and, or Links to websites and shared files, 

together and link them to a number of Components (Assets). You can have as 

many albums as you want and these can contain as many files as you need and 

linked to as many components as necessary. Additional information (attributes) can 

be stored alongside the files and links in an Album.   

An Albums can be created to store the Service Contract documents and details for 

your servers. This album can be linked to all your servers covered by the contract 

and if there is an issue with one of those servers, you can access the Service 

Contract and contact details from that server.  

Fault procedure documents can also be added to an album and linked to the 

devices covered by the procedure. When there is an issue, the engineer dealing 

with the issue just needs to open the appropriate Album linked to the type of fault 

and follow the instructions without having to wade through a list of similar 

documents and decide which one is appropriate for the device currently being dealt 

with. 

A new tab, Albums, has been added to the Assets module. 
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For more details on this new feature see the New Features Training document for 

12.0 

10.1.2 Storing Files in Albums will require MS SQL Filestream 

The new Albums feature is able to store URL/URI Links to websites, documents 

stored on the web and documents stored in shared locations. This does not require 

MS SQL Filestream to be enabled. 

Albums are also able to store files in the SQL database, if MS SQL Filestream is 

enabled and set up. The files are actually stored in a directory on the server that 

only MS SQL should access to. Customers need to consider: the space needed to 

store the files on the server, the DB backup settings and the size of DB backups. 

Because considering these issues requires careful thought and discussions between 

different teams, CS server admin team, Data Storage team, DB Admin team, 

Cormant have designed Albums and the upgrade process to not require Filestream 

to be enabled from the beginning. Instead, customers can upgrade Cormant-CS as 

normal and investigate and use Albums without storing files in the system. Later 

when Filestream has been researched and resources, processes and procedures 

have been agreed and Filestream implemented. Cormant-CS can be enabled to 

make use of Filestream and the ability to store files implemented. 

For more information see the Install Guide 

 

10.1.3 Improvements to Channel Views 

The Connection tabs Channel View is now able to show more information. Users can 

chose attributes (up to seven) to add to the view. These attributes are shown as 

columns of data on the right of the screen. Data is shown in these columns for 

components with those attributes. This will allow users to gain greater insights 

about the Channel and the   elements that make it up. 

A new view has been added to the list. The Channel Details View shows the 

Channels in small discreet tables showing the Rack, Chassis, Module, Port and the 

Sheath, Cable relationships as well as information such as Application / Category of 

the ports and cables along with length and total length of the channel. This view 
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can also be edited similar to the Channel View using the Right click context menu. 

Users can also export this view to PDF, XLS and CSV file formats.  

 

See New Features Training for more details. 

10.1.4 How you find things has been improved  

We have reviewed how users look for things throughout the application. From this 

review we have identified features and methods that work well and combined them 

to create an easier, quicker, and friendlier way to find things. 

Quick Search now operates in more places. To make it clear what is being 

searched a background text has been added, and where appropriate if wild cards 

are supported. Wildcards are used where the need for a single exact match is 

required (Assets module) and remains % and * characters and match 0 or more 

characters. If an exact match is not needed, then leading and training wild cards 

are implied by the search automatically so the user just needs to use a partial bit of 

text which can be in the middle of items being searched. Either way the Tree is 

filtered to the resulting search results showing all matches. 

Selector Dialogs used to choose an item from a tree list, also use partial text 

search (no need for wild cards) and filter the tree when search text is entered.  

Where large trees are being filtered such as in the Space and Template Selector 

Dialogs “lazy loading” is employed. Not all the elements are obtained from the 

server and displayed in one go. The first filtered branch of the tree is shown 

expanded. Other parent branches containing filtered items are also shown, but 

“Closed”. As the user expands these branches further filtered nodes are fetched 

from the server. This makes for a faster, more responsive user experience. 
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10.1.5 Plan View Faster 

On top of the improvements in speed achieved in 11.X, Users should see 

improvements when interacting and editing plan views. When moving away from a 

plan view tab and back again, the view will appear quicker as the plan view data is 

now cached. 

On nested plan views, such as where a Floor has a nested Data Center plan 

embedded in it, device images will not show on racks in the nested plan view when 

in 3D mode.  Clicking on an object within the nested plan view will focus the view 

to just be the nested View and then the Device Images will be shown.  

 

10.1.6 Attributes and Templates have been re-organized 

As part of implementing Albums, we have separated attributes and templates into 

different contexts. These are: Components, Workflow, and Albums. Attributes and 

Templates cannot be moved between contexts. The UI has been modified to make 

this separation clear.  

 

Attributes cannot use the same name as an existing attribute in the same context, 

but attribute names in different contexts can be the same. 

See New Features Training for more details. 
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10.1.7 Other Improvements 

The speed of Importing a large number of components in one file has been 

improved. 

The speed of deleting a large number of components has been improved.  

We have had a “Blitz” on Console errors in the application. These are errors that 

appear in the browser, and while they often to not stop or prevent what the user is 

doing, they do cause “Waits” while the browser decides what to do and slow the 

application down. This combined with other speed improvements should mean that 

users find this version noticeably faster and easier to use. 
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11. List of Enhancements and Bugs by 

Release 

11.1 List of Enhancements in 12.3.2 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-11441 

Add ability to include extra Space root 

in the SQLite DB 

Offline Sync 

Service  

11.2 List of Bugs Fixed in 12.3.2 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-11470 

When syncing data from Android to CS 

Server, the Play Forward process 

created a duplicated cable where it 

should just update an existing one 

Offline Sync 

Service  

CS-11471 

When syncing data from Android to CS 

Server, the Play Forward process does 

not create the cable with the correct 

barcode value 

Offline Sync 

Service  

11.3 List of Bugs Fixed in 12.3.1 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-11310 

Plan View reloads when a rack 

equipment of the current plan is clicked 

on the plan Plan View  

11.4 List of Enhancements in 12.3.0 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-10716 

Move "Enable Data Centers" tab from 

Alerts Module to Admin > Configuration 

Module 

Alerts / 

Configuration  

CS-10715 

Move Thresholds tab from Alerts 

Module to Admin > Configuration 

Module 

Alerts / 

Configuration  

CS-10720 

If a role loses Full permission on Alerts 

and has active subscriptions, then the 

existing subscriptions should be 

removed 

Alerts / 

Subscriptions  

CS-10779 

Add comments to Environment settings 

on CSWeb Settings.config file Application  

CS-10853 

Replace iTextSharp with IronPDF library 

(due to licensing) Application  

CS-10908 

Some DLLs have vulnerabilities and 

should be upgraded Application 31997 
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CS-10858 

Remove jqGrid from CS and HH code 

due to licensing Application  

CS-10854 

Replace AndersonImes.ServiceProcess 

DLL because it is no longer licensed Application  

CS-10805 Add Missing licenses for some DLLs Application  

CS-10575 

Upgrade the remarkable-bootstrap-

notify library to resolve jquery 

deprecation warnings Application  

CS-10459 

Find and resolve jquery deprecation 

warnings Application  

CS-10021 

Display feedback to user RE Dev vs 

Prod instance Application  

CS-10530 

In the Connections tab > Channel 

Details View, nothing happens when 

trying to Export to CSV 

Assets / 

Connections  

CS-10408 

On Assets Module, add ability to 

Import/Export components using 

Component ID Assets / Details  

CS-10407 

On Assets Module, expose Component 

ID system-attribute in the UI Assets / Details  

CS-10548 

Improve Component Export speed by 

loading Space Paths more efficiently Assets / Exports  

CS-10741 

Improve performance of Plan View 

loading / saving by avoiding duplicate 

loading of entities 

Assets / Plan 

View  

CS-9614 

Improve time it takes to save a Plan 

View by not returning the full 

component hierarchy after saving 

Assets / Plan-

view  

CS-10844 

When exporting a Floor Plan, the 

names of devices should be completely 

shown 

Assets / Plan-

view  

CS-10065 Log Plan View actions in History 

Assets / Plan-

view  

CS-2551 

Selected items in Edit mode on floor 

plan are difficult to see 

Assets / Plan-

view  

CS-10763 

Add ability to export Floor Plan as an 

image 

Assets / Plan-

view  

CS-7748 

Loading a Rack row is very slow (in 

rack view).  

Assets / Rack 

View  

CS-7801 

Pre-process template images to 

improve Rack View performance 

Assets / Rack 

View  

CS-10766 

In the Add New Tasks dialog, for Install 

Task Type, add a validation preventing 

the tasks to be created if the selected 

components are not in a Workflow 

Store Room  Assets / Search  

CS-10946 Assets Barcode Search Functionality Assets / Search 32020 

CS-8032 

Improve speed of SP that gets Space 

Path for multiple components Assets / Search  

CS-10587 

In the Assets Search, include 

Component ID to be available in the 

search criteria Assets / Search  
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CS-10312 

From Assets > Search Results tab, add 

ability to link multi-components into an 

album Assets / Search  

CS-10262 

From Assets > Search Results tab, add 

ability to create Workflow Tasks Assets / Search  

CS-10737 

In the Attribute Configuration page, for 

new Datetime Attribute type, the 

Default Value should be changed from 

“Today” to “Now”  

Attributes / 

Configuration  

CS-10546 

Add a new Attribute Data Type to 

support IP Address attributes 

Attributes / 

Configuration  

CS-10164 

Add ability to define Uniqueness type-

property 

Attributes / 

Configuration  

CS-10163 

Add a new Attribute Data Type to 

support MAC Address attributes 

Attributes / 

Configuration  

CS-10160 

Add a new Attribute Data Type to 

support DateTime attributes 

Attributes / 

Configuration  

CS-10689 

Port Unique attribute support to Offline 

HH 

Attributes / 

Configuration  

CS-3619 Ability to make attributes unique 

Attributes / 

Configuration 26109 

CS-10266 

Add support for Audit Connections on 

Offline 

Audit / 

Connections 

Audit  

CS-10895 

Changes by Audit should have history 

log Source as Audit Audit Module  

CS-8255 

Implement way of telling if device 

image changed 

Device Images / 

Details 31347 

CS-10576 

Add logic to check permissions on 

places that use Scheduled Report 

Folders Historical Report  

CS-10482 

In the Saved Attributes configuration, it 

would be good to display the last time 

the Historical process run for each 

attribute Historical Report  

CS-10413 

Add logic to check permissions on 

places that use Historical Report 

Folders Historical Report  

CS-10412 

 Add ability to set Permissions for 

Historical Report Folders Historical Report  

CS-10706 

Add logs when user Run reports and 

when Exporting Components data 

Logs / Report 

History  

CS-10705 

In the Admin > Logs, add a new 

Reports History tab 

Logs / Report 

History  

CS-10747 

In the Query Device dialog, add ability 

to display OID in the dialog 

Network 

Discovery / MIB 

Files  

CS-10746 

In the Query Device dialog, add a Quick 

Search input field so that users can 

easily search Mib table 

Network 

Discovery / MIB 

Files  

CS-11130 

Change port used by CS Offline to 

other port that is not commonly used to 

avoid conflicts in Windows 

Offline / 

Application  

CS-10722 

Add message on DB sync screen telling 

user to update Android app if CS on 

Offline / 

Application  
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server is on newer version 

CS-10308 

Add ability to include extra spaces in 

the Sync Profile 

Offline / 

Application 31936 

CS-10265 

Add ability to support many active Sync 

Profiles on Android  

Offline / 

Application  

CS-6832 

Add validation of changed attributes to 

asset details editing Offline / Assets  

CS-10832 

Add support for new attribute data 

types, IP Address, MAC address and 

DateTime to Offline HH Offline / Assets  

CS-10903 

Include open source license notices in 

Android HH app 

Offline / Code 

Licensing  

CS-10889 

Add ability to play-forward audit 

discrepancies in the Offline Sync 

Service 

Offline Sync 

Manager / Play 

Forward  

CS-10561 

Optimize memory consumption of 

custom reports that have 

space/template filters Performance  

CS-11045 

Permissions Level with the Cut/Copy 

and Paste Operations Permission 31675 

CS-10704 

[Backend] Add ability to disable Export 

function for specific Roles Permissions  

CS-10703 

Add ability to disable Export function 

for specific Roles Permissions  

CS-10857 

In the Permission Reports page, add 

logic to generate and display Scheduled 

Report Folders permission report 

Permissions 

Reports  

CS-10811 

In the Permission Reports page, add 

logic to generate and display Exports 

report 

Permissions 

Reports  

CS-10528 

In the Permission Reports page, add 

logic to generate and display Historical 

Report Folders permission report 

Permissions 

Reports  

CS-10527 

In the Permission Reports page, add 

logic to generate and display Custom 

Report Folders permission report 

Permissions 

Reports  

CS-10526 

In the Permission Reports page, add 

logic to generate and display Space 

Permission report 

Permissions 

Reports  

CS-10525 

In the Permission Reports page, add 

logic to generate and display Zones 

Permission report 

Permissions 

Reports  

CS-10524 

In the Permission Reports page, add 

logic to generate and display Attribute 

Groups Permission report 

Permissions 

Reports  

CS-10523 

In the Permission Reports page, add 

logic to generate and display Modules 

Permission report 

Permissions 

Reports  

CS-10521 

Add new tab to manage Permission 

Reports 

Permissions 

Reports  

CS-10657 

Add ability to send an Email Report to 

many emails 

Reports / 

Scheduled 

Report  
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CS-10503 

Change the UI moving report fields to a 

new tab 

Reports / 

Scheduled 

Report  

CS-10493 

Add ability to copy/cut/paste on 

Scheduled Reports 

Reports / 

Scheduled 

Report  

CS-10492 

Add ability to use drag and drop on 

Scheduled Reports 

Reports / 

Scheduled 

Report  

CS-10490 

Add ability to organize Scheduled 

Reports using report folders 

Reports / 

Scheduled 

Report  

CS-10559 

Add ability to set Permissions for 

Scheduled Report Folders 

Reports / 

Scheduled 

Report  

CS-10886 

Add REST API endpoints for audit 

discrepancies RESTAPI  

CS-10684 

REST API endpoint to set the User 

Account and Password of an EDIS 

Module / Sync RESTAPI 31759 

CS-10742 

Ensure the displayed LastHistoricalRun 

is correct even when the user is in a 

different timezone of the server Saved Attributes  

CS-10642 

In the Saved Attributes page, add "Last 

Historical Run" field Saved Attributes  

CS-11093 

When adding a component (from 

Create or Assign Barcode dialog), add 

ability to autofill the Name field when 

the selected template has Barcode Link 

and there's a valid Barcode Scan & Assign  

CS-11073 

In the Web Service Guide, include extra 

information about some SNMP methods 

to avoid confusion  SOAP API  

CS-10583 

Ensure the SOAP API methods for 

Reports apply validation properly - 

which should consider the Reports 

Module and Report Folder SOAP API  

CS-10509 

DB Tools > Check Database, Rearrange 

the UI to be clearer and more intuitive  

System Settings 

/ DB Tools  

CS-10738 

The settings for environment 

information should be persisted so that 

reinstalling CS doesn't require 

reconfiguring that again 

System Settings 

/ General  

CS-7294 

Put a search field to be able to type in 

the Username instead of scrolling to 

find the name 

System Settings 

/ OAuth  

CS-10187 

Add ability to include Thresholds to 

other templates (e.g. children) easily Templates  

CS-10588 

Add ability to link many thresholds to 

templates Templates  

CS-9597 

Configuration > Templates > Attributes 

- display attributes Unit of Measure 

(UOM) beside attributes 

Templates / 

Attributes  

CS-10185 

Add ability to include Scripts to other 

templates (e.g. children) easily 

Templates / 

Scripts  
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CS-10804 

Request to Increase the Requirement of 

characters set for Password Complexity 

User 

Management / 

Security 31795 

CS-6998 Option to Hide Alerts module per Role 

User 

Management / 

Security 28102 

CS-10809 

In Users & Roles > Permissions tab > 

Attribute Groups section, improve 

Workflow attribute groups 

User 

Management / 

Users and Roles  

CS-10654 

In the User Management → Permission 

tab, hide the option regarding Sandbox 

User 

Management / 

Users and Roles  

CS-9637 

On Admin → User Management → 

Users & Roles tab, make the Users the 

default tab (not Details tab) 

User 

Management / 

Users and Roles  

CS-10655 

When creating a new Role, add ability 

to reuse Permissions from another role 

User 

Management / 

Users and Roles  

CS-10263 

On Select Order dialog, add ability to 

create a new Order 

Workflow / 

Order  

CS-10683 

Validation so that WF Task Create 

dialog Customer Questions with 

Required attributes do not allow user to 

save 

Workflow / Task 

Details 31760 

CS-10764 

Change the logic on Rename Task 

Types to require Device Name only for 

"In Progress" and "Complete" status  

Workflow / Task 

Details  

CS-10734 

In the Assets > Workflow tab, the 

Rename button for an Install Task 

should be enabled 

Workflow / Task 

Details  

CS-10847 

[Workflow: Importing Task] Users will 

be allowed to import a rename task 

with an empty device name. 

Workflow / Task 

Details  

11.5 List of Bugs in 12.3.0 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-8373 

User should only Select one threshold 

at a time  

Alerts / 

Configuration  

CS-11003 Missing vertical scroll in Alerts Alerts Module  

CS-10902 Alert export file is empty Alerts Module  

CS-9713 

Restriction message must be shown 

when the filegroup directory reached or 

will exceed the limit value Assets / Albums  

CS-10368 

Moving a Site with a assets actively 

used in WF causes an error 

Assets / 

Components 31349 

CS-10415 

Multi-disconnect information is not 

quite right when user lacks permission 

to view cables 

Assets / 

Connections  

CS-10278 

Connections tab content still shows 

even when it is set to hidden 

Assets / 

Connections  
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CS-8628 

After disconnecting one, channels 

expand after refresh (JS Tree Upgrade) 

Assets / 

Connections  

CS-10917 

Connects tree not loading if user lacks 

permission to some connected 

components 

Assets / 

Connections  

CS-10475 

Possible to click action buttons while 

changing components in Edit mode Assets / Details  

CS-8590 

Clicking 'Edit' button while loading will 

assume that the tab is in edit mode Assets / Details  

CS-10750 

Discovered Device Details Dialog 

throws an error and doesn’t show any 

information about the device 

Assets / 

Discovery  

CS-10698 

[Assets > Discovery] An error occurs 

when trying to Link a found component 

to a Port  

Assets / 

Discovery  

CS-7494 

Disable right click options for 

components that are shown as 

**Permission Denied** in the History  Assets / History  

CS-7455 

When selecting another space of 

history logs to export, the component 

name of its filename does not change  Assets / History  

CS-7397 

The Change Details (right-panel) 

remains visible even when the main 

table grid has no results to display  Assets / History  

CS-7267 

Filtering History logs by certain 

Template Types has unexpected results Assets / History  

CS-7548 

Import Disconnect is grouped as 

Connect  Assets / History  

CS-10773 

Plan View camera angle resets after 

saving other tab 

Assets / Plan 

View  

CS-10735 

Plan View keeps complaining about 

invalid components that will be 

unpositioned even after saving multiple 

times 

Assets / Plan-

view  

CS-10718 

Plan View takes an abnormal amount of 

time to load on larger DBs 

Assets / Plan-

view  

CS-10319 

Plan View: Performance Issue on 

viewing and editing floor plan 

Assets / Plan-

view  

CS-7878 

Plan View - Rack Front bolding not 

visible in Mobile form factors 

Assets / Plan-

view  

CS-6147 

Clicking 'Cancel' button will save the 

changes made in the rack view. 

Assets / Rack 

View  

CS-10970 

ESC clears Quick Search input on top 

bar, but does not reset tree to 

unfiltered state Assets / Search  

CS-10873 

After linking components to the newly 

created album, there should be a 

notification that components are linked Assets / Search  

CS-10814 

With split screen, when searching for 

an exact match, the Search Results 

should not become the current tab in 

the middle or right panel Assets / Search  

CS-10695 

If there is a previous search, Asset 

Search is reloaded after adding or 

deleting component/s Assets / Search  
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CS-7537 

Notification errors shown when invalid 

characters entered in the Search field Assets / Search  

CS-10815 

Unable to do a search that includes 

Space Path Assets / Search  

CS-11097 

In the Attribute Group page, system-

attribute groups has the Edit button 

wrongly enabled Attributes  

CS-10818 

Action buttons of the parent nodes 

under the Attributes tab are enabled 

Attributes / 

Configuration  

CS-10933 

After searching then creating an 

attribute, the attribute is not included 

in the tree 

Attributes / 

Search  

CS-10401 

After searching then creating an 

attribute, it's not shown in the filtered 

tree Attributes / Tree  

CS-7670 Audit Connections history log  

Audit / 

Connections 

Audit  

CS-11118 

Cancelling connection discrepancy 

resolve still changes the discrepancy 

Audit / 

Connections 

Audit  

CS-11070 

Resolving connection audit discrepancy 

is not connecting expected ports 

Audit / 

Connections 

Audit  

CS-11033 

Error when scanning Equipment 

barcode to skip the port 

Audit / 

Connections 

Audit  

CS-11069 

Assigning barcode to existing 

component in Audit should have Audit 

log Source 

Audit / 

Equipment Audit  

CS-11019 

In the Audit Module, when changing the 

tab from Discrepancies to Details tab, 

the tree is reloaded. Is this correct? Audit Module  

CS-10834 

No notification when searching for a 

component that does not exist Audit Module  

CS-10877 

Console error encountered when 

navigating from Assets to Audit 

Discrepancies tab Audit Module  

CS-10984 

Calculated Attributes service stops 

working after a Network issue or SQL 

connection is down even if it’s already 

resolved. 

Calculated 

Attributes 

Service 31930 

CS-10473 

When running CheckDB to detect Illegal 

Connections in the database, it throws 

a Time Out error Check DB  

CS-10861 

When setting the Config permission to 

None, the Configuration sub-item menu 

is still visible  Configuration  

CS-2557 

OK button of the Historical Report 

Viewer does not respond when clicked Historical Report  

CS-5966 

Performance issue if the 

Component/Rack has script that will 

execute When Modified  

Import 

Components  

CS-10898 

Network Discovery Service fails to find 

devices if one of the addresses in the IP 

Range times out 

Network 

Discovery  
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CS-10840 

Unable to edit Discovery attribute 

mapping 

Network 

Discovery / 

Attribute 

Mapping  

CS-10636 

Some keyboard shortcuts are usable 

even if the associated context menu 

item is disabled Offline / Assets  

CS-10635 

Copy/pasted component is created 

without subcomponents if an error 

occurs [cs offline] Offline / Assets  

CS-10870 

Removing date values results on error 

when saving Offline / Assets  

CS-11080 

Scanning an existing barcode won't 

load the cable details. It needs to click 

anywhere in the dialog before it loads 

Offline / 

Connections 32162 

CS-10612 

When connecting ports in connections 

tab, hitting enter button won’t go to the 

next found node in template lookups. 

Offline / 

Connections  

CS-10613 

Quick search of components with 

multiple results is not working the 

second time  

Offline / Quick 

Search  

CS-10975 

0 results when searching for ports with 

multiple results Offline / Search  

CS-10813 

Connection beep sound does not work 

on windows client or browser 

Offline / 

Windows   

CS-11047 

Unable to edit text fields after clicking 

'OK' on the data-loss warning dialog 

Offline / 

Windows   

CS-5758 

Investigate potential Memory leak in 

Report Caching? Report Caching 27301 

CS-5756 

When there are a lot of reports enabled 

for caching in CSWEB the 

CormantCSReportCachingService stops Report Caching 27301 

CS-10467 

Scheduled Report is being created in an 

invalid state 

Reports / 

Scheduled 

Report  

CS-6913 

Clicking Cancel on the Edit Sync Profile 

dialog will not cancel the changes made 

by the user 

Role 

Management / 

Sync Profiles  

CS-10663 

Console error when clicking 'OK' on the 

Select Attribute window without 

selecting any attributes Saved Attributes  

CS-10784 

The scripting service stops 

intermittently 

Scripting 

Service  

CS-10845 

New ChangeHistory endpoints do not 

return data SOAP API  

CS-10514 

Some methods related to SNMP doesn't 

work properly (SOAP API and Scripting) SOAP API  

CS-10755 

On Templates Config, after adding a 

new template with a filtered tree, the 

template should be shown in the tree Templates  

CS-9478 

Some options in the context menu are 

enabled for parent node 'Workflow' and 

'Album'  Templates  

CS-11056 

Can't add new required attributes to 

existing components 

Templates / 

Attributes  
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CS-10707 

Copying a template does not log to 

Configuration History 

Templates / 

Logs  

CS-10906 

Unable to save Template Script when 

Start Date is set with no end date 

Templates / 

Script 31966 

CS-10752 

[Config] First script in the list, does not 

display the script name on edit mode 

Templates / 

Scripts  

CS-10687 

In Template Script Configuration, the 

input search of the dropdown dialog 

should be aligned to the Script text 

Templates / 

Scripts  

CS-10441 

Date validation when configuring 

Periodic scripts is inconsistent 

Templates / 

Scripts  

CS-10900 

ENTRA ID 2FA prompt does not work 

when using HTTPS. 

User 

Management / 

Security 31922 

CS-10634 

A role with that has "/" character in the 

name can not be accessed 

User 

Management / 

Users and Roles  

CS-11087 

The script tab on the template module 

doesn’t have permission if the admin 

permissions are set to none. 

User 

Management / 

Users and Roles 32140 

CS-10709 

It's possible to disable an Identity 

Provider when it is in use for a Role or 

User 

User 

Management / 

Users and Roles  

CS-10897 

In the Permissions tab, component-

attribute groups that do not have 

attributes on it are not shown in the UI  

User 

Management / 

Users and Roles  

CS-10727 

On Admin > User Management > 

Permissions tab, the data for 

Permissions is out of date  

User 

Management / 

Users and Roles  

CS-7329 

Clicking 'Cancel' on the browser prompt 

when navigating to different role will 

disable the other permission dropdown 

User 

Management / 

Users and Roles  

CS-10829 

[Admin - Users] Copy to Clipboard is 

not working 

User 

Management / 

Users and Roles  

CS-10884 

Workflow > Device Details > Rename 

button still enabled after renaming 

device 

Workflow / 

Device Details  

CS-7851 

Slot Number changes to Original Slot 

Number when in Edit mode 

Workflow / 

Device Details  

CS-10909 

[Workflow import] The device name 

should not inherit the original name 

Workflow / 

Device Details  

CS-2282 

Running/exporting reports causes 

Cormant-CS Business Service memory 

to increase significantly. This causes 

the client and web to stop responding 

Workflow / 

Exports 32064 

CS-10461 

Inaccessible port name is shown in 

clear text in some places and is missing 

in others 

Workflow / 

Provisioning  

CS-10616 

The name of components to which the 

user doesn’t have view permissions are 

shown in clear text in Provisioning tab 

Workflow / 

Provisioning  

CS-10615 

The name of components to which the 

user doesn’t have view permissions are 

shown in clear text in Provisioning 

Workflow / 

Provisioning  
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Details dialog. 

CS-10296 

The value of the Slot Number in the 

Source Location shows an incorrect 

value but shows the correct value in 

EDIT mode. 

Workflow / Task 

Details 31370 

CS-9823 

Canceling an install task with the option 

to rename the device name generates a 

new task. 

Workflow / Task 

Details 30893 

CS-11091 

Print Task > Patch Schedule shows a 

blank page. 

Workflow 

Manager 32182 

CS-11061 

WF tasks grid won't refresh to display 

the changes by Actions 

Workflow 

Manager  

CS-11011 

Green highlight is not visible on rows 

with gray background 

Workflow 

Manager  

CS-10969 

Workflow tasks are not highlighted in 

the task table according to Scheduled 

Date 

Workflow 

Manager  

 

11.6 List of Bugs in 12.2.1 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-10900 

Entra ID 2FA prompt does not work 

when using HTTPS 

Security / 

Authentication 31922 

 

11.7 List of Enhancements in 12.2.0 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-2961 

To provide the information about the 

delete process when deleting large 

spaces with components and 

connections 

Assets / 

Components  

CS-2374 

Enhancement Request for the Imports 

Feature 

Assets / 

Components 25150 

CS-3791 

Needs Import progress icon/bar in CS 

Web Import  

Assets / 

Components  

CS-9885 

Add real-time capabilities to the app 

using SignalR 

Assets / 

Components  

CS-9859 

When Deleting a component, open a 

dialog with a progress bar 

Assets / 

Components  

CS-9860 

When importing a file on CSWEB, open 

a dialog with a progress bar 

Assets / 

Components  

CS-9726 

Improvement for the multiple 

disconnect feature to disconnect cables 

without the need of specifying the 

destination ports. 

Assets / 

Connections 30749 

CS-10097 

[UI] Consistency in the Confirmation to 

disconnect dialog 

Assets / 

Connections  
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CS-8767 

Add Cancel-able Waiting Spinner to 

Asset History Assets / History  

CS-10191 

Editing name of component in Search 

Results should optionally rename 

subcomponents Assets / Search  

CS-8483 

Enhance the ability of CheckDB tool to 

detect invalid date values Check DB 

29929, 

30399 

CS-10014 

Replace custom date/time pickers with 

browser-based pickers CSWeb  

CS-10391 

Improve Historical Report Lookup to 

show folders Dashboard  

CS-10057 

Add Cylinder fill chart to dashboards, 

using same config options as for Meter 

types. Dashboard  

CS-8880 

Add Thermometer chart to dashboards, 

using same config options as for Meter 

types.  Dashboard  

CS-10056 

Add Vertical LED chart to dashboards, 

using same config options as for Meter 

types. Dashboard  

CS-10620 

Consistent change history logging when 

a record is edited but not changed? 

Logs / 

Administration 

History  

CS-10207 

Set the logging of EDIS Service logs to 

use standard filename date suffix 

format as YYYYMMDDHhMmSs.Ns 

Logs / EDIS 

Logs 31306 

CS-10367 

In the Login History page, add ability to 

show when someone tried to login 

passing an invalid "redirect URL" 

parameter (malicious agent) 

Logs / Login 

History  

CS-10366 

On Login History page log, include a 

new Reset button in the filter section 

Logs / Login 

History  

CS-10430 

Add server-side pagination to Scripting 

Logs page Logs / Scripts  

CS-10547 

Improve the Script dropdown field to 

use a Filtered Dropdown Logs / Scripts  

CS-9861 

In the Admin > Logs > Scripts page, 

improve how the table is refreshed 

based on the Auto-Updates feature  Logs / Scripts  

CS-10365 

Make Scripting Logs use server-side 

filtering so that it's possible to easily 

look for old data Logs / Scripts  

CS-9890 

In the Admin > Logs > Scripts page, 

investigate why the Filter does not 

always work as expected Logs / Scripts  

CS-10547 

Improve the Script dropdown field to 

use a Filtered Dropdown Logs / Scripts  

CS-10336 

Replace custom date/time pickers with 

browser-based pickers Offline / Assets  

CS-9096 

Mobile - Scan and Assign - Add Asset 

RU and Template data Offline / Assets  

CS-8544 pagination is inconsistent with CS Web Offline / Assets  

CS-10321 

Offline HH > Settings > Sync Service 

Address field validation Offline / Assets  
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CS-7129 

Implement logic for the "Sort by Rack 

Unit" feature (Context menu) Offline / Assets  

CS-10307 

On Offline, improve Space Lookups to 

display Filtered Results (same as 

CSWEB) Offline / Assets  

CS-10306 

On Offline, improve Template Lookups 

to display Filtered Results (same as 

CSWEB) Offline / Assets  

CS-10305 

On Offline Android, include missing 

features on Assets Tree and Create and 

Assign Barcode dialog Offline / Assets  

CS-8064 

Ensure that the improvements done by 

CS-7796 and CS-7762 are also applied 

on Android Offline / Assets  

CS-8557 

Port CS-8491 and CS-8492 to Android 

handheld Offline / Assets  

CS-10585 

Change style of the Settings buttons on 

login page Offline / Login  

CS-10320 

Create a Windows installer for CS 

Offline 

Offline / 

Windows  

CS-10477 

Add a Loading Spinner to Custom 

Reports Reports  

CS-10476 

Add more information on 

Administration History when editing 

Reports Reports  

CS-10389 Add ability to use drag and drop Reports  

CS-10388 Add ability to use Keyboard shortcuts Reports  

CS-10201 

Report Viewer - Add support to sort by 

column headers 

Reports / 

Custom Reports  

CS-10261 

Report Viewer - Add support to sort by 

column headers when attributes show 

count or sum 

Reports / 

Custom Reports  

CS-10429 

Custom Report part of report tree loads 

very slowly 

Reports / 

Custom Reports  

CS-10269 

Report Viewer - Add support to sort by 

column headers in Details view 

Reports / 

Custom Reports  

CS-10479 

In the Reports > Historical Report, the 

Attribute dialog should display only 

Saved Attributes, not all existing 

attributes  

Reports / 

Historical Report  

CS-7070 

Ability to add Folders for Historical 

Reports. 

Reports / 

Historical Report 28133 

CS-9479 

Add pagination support to REST API 

/ComponentAttributes endpoint REST API  

CS-10480 

In the Saved Attributes configuration, 

the attributes tree should also display 

the attribute parent (in this case, the 

attribute group) Saved Attributes  

CS-10114 

Add ability to specify the Identity 

Provider for each User 

Security / 

Authentication  

CS-10083 Add Guest User settings into CSWEB 

Security / 

Authentication  
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CS-10082 Add LDAP settings into CSWEB 

Security / 

Authentication  

CS-10220 

Add OpenID Connect (OIDC) 

configuration to Admin > User 

Management > LDAP & SSO tab 

Security / 

Authentication  

CS-10222 

Implement OpenID Connect for Azure 

AD SSO in CS Web using MS libraries 

Security / 

Authentication  

CS-10093 

Investigate the use of Azure AD to 

Authenticate and Authorize users 

Security / 

Authentication  

CS-10667 

Roles should have option for default 

Entity Provider 

Security / 

Authentication  

CS-9874 

Provide a validation when an Order 

with active tasks is deleted via API 

DeleteOrderByID. SOAP API 30715 

CS-9837 

There should be an API validation when 

running DeleteTaskByID API SOAP API 

31617, 

31506 

CS-10186 

The buttons on Thresholds and Scripts 

tabs do not have the same colors Templates  

CS-9160 

Show user roles in Login History and in 

the export file in order to be able to 

filter via user roles User and Roles 30369 

CS-10115 

Add Azure AD SSO configuration to 

Admin > User Management 

User 

Management / 

Security  

CS-10310 

In the Admin > Users Managements > 

Users tab, add ability to export users 

table-grid 

User 

Management / 

Users and Roles  

CS-10309 

In the Admin > Users Managements > 

Users tab, add new columns in the 

table-grid 

User 

Management / 

Users and Roles  

CS-9638 

On Admin → User Management → 

Users & Roles → Users tab, improve the 

Role dropdown field to use a Filtered 

Dropdown 

User 

Management / 

Users and Roles  

CS-9855 

In the User Profile Settings, a non-

admin user should not be able to 

change his email User Profile  

CS-9769 

Add basic "Rack Selector Scores" 

export in a Pop-up Dialog  

Workflow / Rack 

Selector  

CS-9780 

Improvements on the "Rack Selector 

Score" dialog 

Workflow / Rack 

Selector  

CS-9777 

In the "Rack Selector Scores" dialog, 

add ability to select the row, then 

update the Rack/Location field 

Workflow / Rack 

Selector  

CS-9779 

In the "Rack Selector Scores" dialog, 

add ability to show available slots of 

the Rack 

Workflow / Rack 

Selector  

CS-9056 

There should be a warning when 

Chassis are decommissioned and their 

blades have pending decomm tasks 

Workflow / Task 

Details 

30313, 

30690 

CS-10496 

Workflow Submit Date Time attribute 

greyed out/disabled. 

Workflow / Task 

Details 31461 
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11.8 List of Bugs Resolved in 12.2.0 

Item Key Summary 
Cormant 

Component 

Custome

r Case 

Number 

CS-10294 

User with Config-None permission, 

does not show the Album template 

icons properly Admin / Album  

CS-9678 

Cannot create an album when Template 

has required attributes Assets / Album  

CS-9718 

[Albums] Console error when dragging 

files around or on top of the Albums 

area Assets / Album  

CS-10274 

Unable to unlink the last linked 

component from an album (depending 

on permissions) Assets / Album  

CS-10577 

Assets > Albums > Edit button 

becomes enabled when it should 

remain disabled Assets / Album  

CS-10598 

When navigating to Albums tab after 

discarding changes on Details tab, the 

Albums tab shows the page in edit 

mode Assets / Album  

CS-10669 

Zone permission is not applied for 

Album custom required attributes 

endpoint Assets / Album  

CS-10379 

Optional Attributes in Add Components 

dialog does not load the default 

template attribute value 

Assets / 

Components  

CS-10625 

Copy and Paste Permissions of Users 

with a Required Attribute 

Assets / 

Components 31675 

CS-10678 

Console error encountered when 

searching for existing cable or 

component in the Connections dialog 

Assets / 

Components  

CS-8511 

First created virtual cable of a template 

with barcode link has non-empty 

barcode 

Assets / 

Connections  

CS-9028 

Multiple connect on ports with patch 

schedule while Task is In Progress, 

should be restricted 

Assets / 

Connections  

CS-9956 

[Edge] Format dropdown on the 

Connections tab moves to the side 

when hovered 

Assets / 

Connections  

CS-10313 

Unable to make connection when 

creating sheath via multiple connect, 

restricted by WF task 

Assets / 

Connections  

CS-10314 

Deletion confirmation message contains 

inaccessible component name 

Assets / 

Connections  

CS-10315 

Multi-connect hangs in certain 

situations 

Assets / 

Connections  

CS-10384 

Connected range logic doesn't find 

connected range if one of the spaces is 

not accessible 

Assets / 

Connections  

CS-10550 

Error when using Multi Connect drag'n 

Drop "unsupported connectivity level..." 

Assets / 

Connections  
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CS-7986 

Move notification should contain name 

of moved component Assets / Details  

CS-8944 

Text can be hidden within fields by 

using curly braces Assets / Details  

CS-9303 

There should be a restriction when 

'Template Component' is used as 

Template  Assets / Details  

CS-9896 

Copied component with default date 

value in its template show an invalid 

date value error Assets / Details  

CS-10257 

A validation error occurs when trying to 

Add Multiple Components with a 

Template that has default value in a 

date-type attribute Assets / Details  

CS-10271 

[Components] Inconsistent date-type 

attribute values in Component_Attrib 

table when adding vs updating Assets / Details  

CS-10292 

Errors encountered when the user has 

Components-None permission Assets / Details  

CS-10193 

Wrong tab shown after quick searching 

for component then clicking on health 

card 

Assets / 

Healthcards  

CS-9554 

In Asset History, date attributes are not 

being displayed in the user’s chosen 

date format Assets / History  

CS-9562 

In Asset History, date attributes are not 

stored in ISO format Assets / History  

CS-10674 

[Move Here] Console error encountered 

after valid component is entered in the 

input search when Auto Advance is OFF 

Assets / Move 

Here  

CS-9887 

[Planview] Other tab does not get 

updated when adding / removing / 

changing image of plan view 

Assets / Plan-

view  

CS-9899 

[Planview] Error when updating the 

floor plan on a different panel after 

deleting on the other one 

Assets / Plan-

view  

CS-10060 

[IOS] 'Rotate' button in the Plan View is 

not working using iPhone 

Assets / Plan-

view  

CS-9686 

[Assets > Search Results] After 

deleting a component, the component 

is still visible in the Search Results tab Assets / Search  

CS-10194 

Clicking twice on a search result cell 

while in Edit Mode shows data loss 

confirmation dialog Assets / Search  

CS-10236 

[Assets Search] Order of records on the 

printable page do not match what is 

shown in the search result table Assets / Search  

CS-10298 

On Assets Search, the date filter 

criteria doesn't work when providing 

just the Date From  Assets / Search  

CS-10602 

[Search] Error when saving Search 

filters Assets / Search  

CS-10650 

[Quick Search] 0 results when 

searching for ports with multiple results Assets / Search  
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CS-10433 

[SNMP Configuration] In the Assets > 

SNMP Configuration dialog, the SNMP 

Version is not saved properly Assets / SNMP  

CS-10280 

[Asset] 'History' tab keeps on showing 

after setting the Workflow permission 

to 'Hidden' Assets / Tabs  

CS-10007 

[Attributes] Consistency of validation 

for Alpha-type attributes 

Attributes / 

Details  

CS-10595 

Modifying Attributes does not take 

effect if the User who modified the 

changes is the User under the new role 

created. 

Attributes / 

Details 31626 

CS-10303 

[Attributes] Copy pasting when the 

Attributes tree is filtered generates 

console error Attributes / Tree  

CS-9738 

On Scripts page, an error occurs after 

selecting a node, and then try 

refreshing the page 

Configuration / 

Scripts  

CS-7745 

User without access to CSWEB setup as 

SSO (AD login) gets directed to a Login 

dialogue over a Blank page CSWEB 28600 

CS-10226 

Pagination page numbers formatted 

incorrectly CSWeb  

CS-10431 

[Dashboard] In the Alert Summary 

Widget, the Orientation input field 

doesn't work as expected Dashboard  

CS-10554 

[Dashboard] Tooltips on Planview 

widget don't disappear when hovering 

outside of the widget box Dashboard  

CS-10470 

Multi-line errors are not shown in 

multiple lines on notification Error Message  

CS-10581 

[Import] Unable to import connections 

using CSV file, generates a 'Stream 

was not readable.' error Imports  

CS-10653 Uniform logging of changes in Reports 

Logs / 

Administration 

History  

CS-10700 

[Configuration History Logs] Move 

Template entries shows the same From 

and To in the Description 

Logs / 

Configuration 

History  

CS-10494 

[Logs] No history entry when logging in 

with incorrect Username 

Logs / Login 

History  

CS-7658 

Monitoring the Scripts Log hogs all 

memory resource over time Logs / Scripts 28168 

CS-10332 

[MIB Files] Error on left panel when 

clicking on MIB files tab 

Network 

Discovery / MIB 

Files  

CS-10143 Port hidden text fix to Android Offline / Assets  

CS-10322 

[Android] Subcomponents are not 

created in CS after encountering the 

error 'attribute not being a valid date 

value' Offline / Assets  

CS-10323 

[Android] Unable to sync components 

with default date values from Android Offline / Assets  
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to Web  

CS-10324 

[Android] Creating multiple 

components using template with 

default date value causes an error Offline / Assets  

CS-10405 

[Android] The sorting of components in 

the Assign Component lookup tree 

ignores the 'Sort by Rack Unit' feature Offline / Assets  

CS-10406 

[Android] Error when syncing renamed 

cable from Android to CS Web Offline / Assets  

CS-10501 

[CS Offline Windows] Unnecessary 

horizontal scroll bar on the Sync 

Management page Offline / Assets  

CS-10502 

[CS Offline Windows] Doing a quick 

search while in Sync Management page 

returns a blank screen Offline / Assets  

CS-10531 

In the Cormant-CS Offline available on 

Windows, the Template Lookup 

requires wildcard to search correctly. In 

practice, it should not. Offline / Assets  

CS-10586 

[CsOffline - Windows] Seach results 

page has an empty left panel on large 

resolutions Offline / Assets  

CS-10053 

On small screens, long tree text 

overflows to the right beyond the tree 

background image 

Offline / 

Connections  

CS-7441 

Incorrect file extension when Report 

Title uses an apostrophe Reports 28154 

CS-10033 

[Reports] “Unable to Complete 

Request” error page is shown when the 

report name includes the word “index”. Reports  

CS-10592 

In the Reports Module, there are no 

notifications when a report is saved Reports  

CS-10563 

[Reports] Name on the reports tree and 

center page is not updating after 

renaming it under Details tab 

Reports / 

Custom Reports  

CS-10564 

[Reports] Console error when exporting 

a meter chart with no data 

Reports / 

Custom Reports  

CS-10596 

[Reports] When saving a report with a 

new report folder, the tree is not 

updated  

Reports / 

Custom Reports  

CS-10597 

[Reports] When renaming a report, the 

tree is not updated properly 

Reports / 

Custom Reports  

CS-10658 

[Reports] Export format dropdown 

should be disable when no data is 

found 

Reports / 

Custom Reports  

CS-10626 

No Saved Attribute is selected when 

searching 

Reports / 

Historical Report  

CS-10481 

[Historical Reports] It isn't possible to 

copy a Historical Report 

Reports / 

Historical 

Reports  

CS-9978 

[Reports] Running standard reports 

with  an invalid date value generates 

an unfriendly error 

Reports / 

Standard 

Reports  



 Cormant-CS 

Cormant-CS Release Notes 45  
 

CS-10295 

On REST API, endpoints for Updating 

and Creating Component Date 

Attributes should be consistent RESTAPI  

CS-10614 

 Unexpected behavior after deleting the 

last Saved Attribute Saved Attributes  

CS-10383 

Deadlock causes data fetch to fail in 

case Scripting Service is adding too 

many logs very frequently 

Scripting 

Service  

CS-10545 

[Scripts] Saving twice on the Templates 

tab results to an 'Object reference error 

will show' Scripts / Details  

CS-10549 

[Scripts UI] When collapsing the Details 

section, a blank space appears in the 

end of the page Scripts / Details  

CS-10334 

CS Web is vulnerable to Open 

Redirection attacks Security  

CS-10135 

Unfriendly error message when using 

Windows Authentication without a 

matching CS user Security / Login  

CS-10491 

[Login] No UI validation when logging 

in with incorrect Username Security / Login  

CS-10045 

SOAP API does not return error when 

trying to connect port that is disabled SOAP API  

CS-10325 

[SOAP API] 

ComponentServices.GetLegacyChangeH

istoryItems does not work SOAP API  

CS-10326 

[SOAP API] 

ComponentServices.GetChildComponen

tsByIDType does not work SOAP API  

CS-10327 

[SOAP API] 

ComponentServices.GetChildComponen

tsByNameType does not work SOAP API  

CS-10339 

[CSWEBAPI] GetAttributeGroupByID 

and  GetAttributeGroupByIDs does not 

return values SOAP API  

CS-10132 

[Mail settings] Username and Password 

fields are automatically set 

System Settings 

/ Mail Settings  

CS-8925 

[Templates] Error when updating and 

saving all attributes of a template in 

one go. 

Templates / 

Attributes  

CS-10544 

The import passes the validation check 

but then fails to import. 

Templates / 

Export - Import 00031625 

CS-10686 

"Script is required", error message is 

gone, now a warning notification  

Templates / 

Scripts  

CS-10134 

Guest users not logged-out when 

disabling guest user access 

User 

Management / 

Security  

CS-10136 

[Workflow] Updating device 

Rack/Location does not clear up Unit 

Location on the first time 

Workflow / 

Device Details  

CS-10460 

Error is thrown when trying to open the 

dialog for a Patch Schedule that is 

connecting to inaccessible component 

Workflow / 

Provisioning  

CS-10460 

Error is thrown when trying to open the 

dialog for a Patch Schedule that is 

Workflow / 

Provisioning  
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connecting to inaccessible component 

CS-10496 

Workflow Submit Date Time attribute 

greyed out/disabled. 

Workflow / Task 

Details 31461 

11.9 List of Enhancements in 12.1.0 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-9857 

Cormant-CS should be able to generate 

a 6-digit code to allow Two-Factor 

Authentication Security / 2FA  

CS-9761 

In the Mail Settings tab, add validation 

preventing Email Server Details to be 

deleted in case 2FA is enabled Security / 2FA  

CS-9762 

When enabling Two-Factor 

Authentication, the Admin user should 

be able to test if Email Server is 

working (new dialog) Security / 2FA  

CS-9763 

The Admin user should be able to by-

pass 2FA (i.e. disable) for a specific 

user Security / 2FA  

CS-9764 

In the User Profile Settings, allow the 

user to know their 2FA status (enabled 

or not) Security / 2FA  

CS-9765 

When the Admin user enables Two-

Factor Authentication, the system 

should set the 2FA status on each user Security / 2FA  

CS-9766 

When creating a new user, the system 

should default the 2FA status for that 

user based on the global 2FA status Security / 2FA  

CS-9768 

When trying to log-on on CSWEB, the 

user should be able to set if the 

authorization should be remembered in 

that browser Security / 2FA  

CS-9878 

Send 6-digit token to the user via email 

with instructions on how to proceed Security / 2FA  

CS-9879 

In the Security page, the admin should 

not be able to enable 2FA if the user is 

using Single Sign-On (Windows 

Authentication) Security / 2FA  

CS-9883 

Ensure 2FA is not applied on any case 

using APIs Security / 2FA  

CS-9916 

When the Admin user disables 2FA 

globally, the system should not change 

all users 2FA status Security / 2FA  

CS-9997 

Add traceability when user tries to log-

in on CSWEB using 2FA - New status 

options on Login History Security / 2FA  

CS-9998 

Show SSL validation notification before 

2FA confirmation dialog Security / 2FA  

CS-5813 

[Web] Setting Values on Low and High 

Thresholds in Alerts Module 

Alerts / 

Thresholds 27349 

CS-10022 

[Albums] Disable the other panel's 

buttons when the Album on the other Assets / Album  
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panel is in edit mode 

CS-10151 

Improve text in Deleted Selections 

dialog 

Attributes / 

Details  

CS-8209 

No Restriction when deleting an item 

from the selection list of Selection type 

attribute 

Attributes / 

Details 

29775, 

30160, 

30760 

CS-10026 

Lookup for selecting attributes should 

select nodes on search 

Attributes / 

Search Picker  

CS-9852 

Add filtered search to 

SingleValueLookup that uses Chassis 

Source Type 

Components / 

Assets Search 

Picker  

CS-9853 

Add filtered search to 

SingleValueLookup that uses Order 

Source Type 

Components / 

Assets Search 

Picker  

CS-9854 

Add filtered search to 

SingleValueLookup that uses Icon 

Source Type 

Components / 

Assets Search 

Picker  

CS-4162 

Fix security vulnerabilities by upgrading 

jQuery, Moment, and Bootstrap CSWEB  

CS-9346 

Increase the character limit of Widget 

name Dashboard  

CS-10204 

Clicking the Date field clears the value 

to show the date picker Date and Time  

CS-10180 

Add an option to Connections Import to 

skip Empty Ports when disconnecting 

Import / 

Connections  

CS-2855 Update Marionette to v3.4+ 

Security 

Updates  

CS-4162 

Fix security vulnerabilities by upgrading 

jQuery, Moment, and Bootstrap 

Security 

Updates  

CS-10036 

Expose SNMP async methods in SOAP 

API SOAP API  

CS-10150 

Update Scripting documentation so that 

it talks about async methods and config 

parameters SOAP API  

CS-10157 SOAP API: New History Endpoint SOAP API  

CS-10030 

Adjust left panels that have informative 

Text so that they can be well-resized 

when using resizable panel User Interface  

CS-9882 

Improve the messages for some Asset 

tabs with blank pages.  User Interface  

 

11.10 List of Bugs Resolved in 12.1.0 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-10073 

[Albums] Showing the attachment's 

context menu and then clicking the 

History tab, displays blank page and 

generates console error 

Admin / Album  
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CS-10203 

The last used template when creating 

an album is set automatically in the 

Album search criteria, Template field  

Admin / Album  

CS-10202 
[Admin Album] Album Template is not 

cleared when clicking the Clear button 
Admin / Album  

CS-10131 
Exporting Albums exports all of the 

items searched in the list 
Admin / Album  

CS-10074 

[Albums] Server error when opening 

an attachment that is deleted from the 

database 

Admin / 

Attachment 
 

CS-10071 

[Small Screen] Album attachment 

context menu under Admin>Albums is 

not showing 

Admin / 

Attachment 
 

CS-9994 

If FileStream DB was previous deleted, 

on Album Settings the user should be 

able to set Allow Upload Files to No  

Album 

Configuration 

and settings 

 

CS-9376 

[Albums] Setting 'Today' as default 

value for Date-type album attributes 

shows as 01/01/2001 on Assets 

module 

Album 

Configuration 

and settings 

 

CS-10218 
Cannot create an album with a date 

attribute set to a default date 

Album 

Configuration 

and settings 

 

CS-10023 

In the Admin > System Settings > 

Albums tab, the Quick Search field 

(from top-bar menu) shows the wrong 

placeholder text 

Album 

Configuration 

and settings 

 

CS-10293 

User with View-only permission to the 

component/space can link/unlink an 

album 

Album Linking 

and Unlinking 
 

CS-9623 
[Alerts Module] The vertical line of the 

resizable panel is not displayed 
Alerts  

CS-10123 
Alerts Export - display DC and Rack 

columns missing on Export  
Alerts  

CS-10208 
[Alerts] Unable to delete enabled Data 

Center 
Alerts  

CS-3420 

[Web] No restriction when creating a 

threshold with no Value Attribute or 

Max Value Attribute 

Alerts / 

Thresholds 
 

CS-9228 
Deleting the Color Range/s will also 

delete the Thresholds. 

Alerts / 

Thresholds 
30420 

CS-10011 
In the Thresholds some columns are 

not displaying the X icon properly 

Alerts / 

Thresholds 
 

CS-9428 
[Android] Exception error when 

updating template on the Android 
Android / Assets  

CS-9414 

[Android] Date attributes still consider 

the character length even though it is 

set to Date data-type. 

Android / Assets  

CS-10090 

[Android] On History tab, the From 

value is empty when changing a date 

attribute 

Android / Assets  

CS-9413 
[Android] Unable to add a component 

with default value on date fields 
Android / Assets  

CS-9432 
[Move Here] Date attribute not existing 

to the component shows invalid date 

Android / Move 

Here 
 



 Cormant-CS 

Cormant-CS Release Notes 49  
 

CS-10067 

Unfriendly error message when 

opening album file if filestream 

database exists but is offline 

Assets / Album  

CS-10042 

[Albums] Pressing the 'Enter' button 

when capturing images generates 

console error 

Assets / Album  

CS-9989 
[Album] There's a typo when showing 

the validation message for Album File 
Assets / Album  

CS-10078 

[Albums] Attachments context-menu 

delete and rename actions are not 

disabled on edit 

Assets / Album  

CS-10259 
Albums not created according to the 

component's Zones permissions 
Assets / Album  

CS-10154 
Unconventional warning message style 

when template is blank 

Assets / 

Components 
 

CS-10153 
Error notification when changing Space 

lookup in Add Components dialog 

Assets / 

Components 
 

CS-8984 

Conduits tab leaves edit mode when 

adding or moving to a different tab on 

the other panel 

Assets / 

Conduits 
 

CS-10173 

Deleting cable via the Details tab 

results in Loading state of the 

Connections tab and the 'Unable to 

Complete Request' page 

Assets / 

Connections 
 

CS-8898 
Connecting ports when Connectivity is 

Disabled should be restricted 

Assets / 

Connections 
 

CS-10096 
Show the component's ports when the 

barcode is entered in the To Port 

Assets / 

Connections 
 

CS-9980 
[Import] The Connection Tree appears 

to be loading for 5-10 minutes 

Assets / 

Connections 
 

CS-10258 
Channel Detail View has error if part of 

the circuit is **Permission Denied** 

Assets / 

Connections 
 

CS-10277 
[Connections] Inconsistent permission 

when connecting virtual cables 

Assets / 

Connections 
 

CS-8980 

[Assets] Clicking OK on the data loss 

warning will let the other panel enables 

the Edit button. 

Assets / Data 

Loss 
 

CS-10001 
[Rack View] Navigating to different tab 

does not cancel edit mode 

Assets / Data 

Loss 
 

CS-10216 

Clicking 'OK' on the data-loss warning 

dialog causes the Rack View to leave 

edit mode when clicking different tab 

on the right panel 

Assets / Data 

Loss 
 

CS-9127 
Assets Details does not load the page if 

the Attribute has invalid data 
Assets / Details  

CS-9042 
"Service Environment" not aligned in 

Edit mode of Asset details 
Assets / Details  

CS-9004 

Changing Template in Assets Module 

prompts that there are Subcomponents 

to be deleted when there's None 

Assets / Details 30295 

CS-10095 

In the Add Component dialog, the 

validation message for Template field 

is shown in the wrong place 

Assets / Details  

CS-10137 
Template field should highlight in red 

when adding component/s without a 
Assets / Details  
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Template value 

CS-10200 

Selecting a template on an invalid or 

unknown cable brings up an Album 

templates selection instead of a Cable 

templates selection. 

Assets / Force 

Connect 
31294 

CS-9126 

Changing the Attribute type for an 

Attribute that is being used by a 

Template can lead to invalid data. 

Should we allow that? 

Assets / History  

CS-9904 

[Planview] Add a space between the 

text restriction and the 'Select Image 

File' button 

Assets / Plan-

view 
 

CS-4674 

Navigation confirmation appears while 

editing floor plan when clicking on 

ports in the Asset Tree 

Assets / Plan-

view 
 

CS-9547 
Report - xpos, ypos and vertices report 

blank 

Assets / Plan-

view 
 

CS-10020 

[Planview] Searching for a component 

with planview generates a console 

error  

Assets / Plan-

view 
 

CS-9846 

[Planview] Navigating on nested 

planview while on edit mode does not 

show the data loss warning message 

Assets / Plan-

view 
 

CS-10072 
[IOS] Context menu on the Rack View 

is not showing 

Assets / Rack 

View 
 

CS-10047 

[Rack View] Unable to click the 

'Options' button after changing the 

Rack View to 'Rack Images Only' 

Assets / Rack 

View 
 

CS-10152 

[Rack View] Tooltips don't disappear 

after moving the equipment within the 

rack 

Assets / Rack 

View 
 

CS-5837 
Asset Search results is using wrong 

value for XPos and YPos and Vertices 
Assets / Search  

CS-9105 

[Search Results] No validation for 

system-defined numeric attributes 

when updated via the Search Results 

tab 

Assets / Search  

CS-10075 Data-automation tag missing Assets / Search  

CS-9739 
[Search Results] Export button is still 

enabled when in Edit mode 
Assets / Search  

CS-10048 
Asset Search by XPos, YPos, Vertices 

not working as expected 
Assets / Search  

CS-9187 

Searching with multiple results from a 

different Site, if starting space 

specified is not All Spaces, does not 

show the root node 

Assets / Search  

CS-10199 

Search Results rows are not being 

highlighted according to save results 

(functionality that existed up to 9.4) 

Assets / Search  

CS-10198 

Saving empty value for numeric 

attribute in Search Results tab causes 

the state of the component after save 

to be inaccurate 

Assets / Search  
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CS-8403 

Clicking again the active tab that is in 

Edit mode prompts the confirmation 

message in the right panel 

Assets / Split 

Screen 
 

CS-9023 

[Assets] No data loss warning when 

navigating from Rack View to Asset WF 

while in edit mode 

Assets / Tabs  

CS-10210 

[Assets] When one tab is set to 

Hidden, it's possible for the right panel 

to have no tabs. 

Assets / Tabs  

CS-9218 
Components are not shown when the 

tree is showing as shortened. 
Assets / Tree  

CS-5928 

When deleting an Attribute that's used 

as HH Attribute, unlink the Attribute in 

SystemSettings 

Attribute / 

Details 
 

CS-9561 

Attribute with a Selection Data type 

defaults to the 1st value from the 

Selection list when used in a Workflow 

template 

Attribute / 

Details 
30689 

CS-8913 
Selection type attribute must remove 

blank/space in the list when saved 

Attribute / 

Details 
 

CS-10006 

[Attributes] Error when copy-pasting 

required selection-type attribute with 

blank default value 

Attribute / 

Details 
 

CS-10228 
Validation Date attribute field is cleared 

when deleting a Handheld Attribute 

Attribute / 

Details 
 

CS-10121 

[Reports] The attribute lookup keeps 

previously checked attributes and 

needs the user to remove manually if 

they are not needed 

Attributes / 

Search Picker 
 

CS-9804 
When an attribute is deleted, the 

Report that uses it throws an error    
Attributes / Tree 30899 

CS-10138 

Cursor focus is lost after making the 

first search in the Templates and 

Attributes pages 

Attributes / Tree  

CS-6130 

[Audit Quick Search] When a searched 

text has many possible results, cursor 

focus is lost in the quick search field 

Audit Module  

CS-9265 
Fix Calculated attribute service log data 

at info level, far too verbose 

Calculated 

Attributes 

Service 

 

CS-7892 
Workflow Settings don't have a 

resizable handle 
Configuration  

CS-9939 

[Configuration] Workflow Ref Data 

quick search field shows wrong 

placeholder text  

Configuration  

CS-9932 

[Dashboard] Component lookup field 

value still persists even after cancelling 

the changes on the Planview widget 

Dashboard  

CS-9571 
Workflow widget table exceeds 

dashboard widget content area 
Dashboard  

CS-9983 
SQL credentials shows in some Service 

logs when set on Debug mode 
Database Wizard  

CS-10054 

[Small Screens] 'Fix Errors' toggle 

button is not aligned with the other 

buttons  

DB Tools  
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CS-9957 

Page unresponsive when clicking the 

check all checkbox in any EDIS module 

> Logs > Actions 

EDIS UI  

CS-10213 

[Admin Albums] Sorting on the 

exported file is based on the created 

column, ignores the sorting set by the 

user 

Export / Album  

CS-3963 
[CSWeb] Historical Report Viewer: Bug 

when selecting the Date range 
Historical Report 26316 

CS-7612 
Historical Report Viewer displays old 

name of a renamed component. 
Historical Report 28445 

CS-10051 

On SOAP API, an error exception 

occurs when trying to run 

ReportServices.GetHistoricalReportDat

a endpoint 

Historical Report  

CS-10089 

On SOAP API, an error exception 

occurs when trying to run 

ReportServices.GetReportByID 

endpoint 

Historical Report  

CS-9946 
Error when attempting to rename 

component via import 
Imports 31029 

CS-9897 
Unable to use Subscription license 

when installing Server 
Licensing  

CS-9250 

Fix indexing/query for Offline sync log. 

Takes about 45 seconds to load on 

DCIM11 server (been running for a 

year) 

Offline Sync 

Manager / Logs 
 

CS-9422 
Include username in the Offline sync 

log on Error 

Offline Sync 

Manager / Logs 
 

CS-8904 
No data loss warning when leaving the 

User Profile Settings while in Edit mode  

Per-User 

Settings 
 

CS-9921 

In the System Settings > Workflow 

Settings tab, the Quick Search field 

(from top-bar menu) shows the wrong 

placeholder text 

Quick Search  

CS-9841 
Buttons in long toolbars of some pages 

resize when hovered in small screen 
Reports  

CS-7557 
Issues with 'Overlapping Allowed' 

attribute when used in Reports 

Reports / 

Custom Reports 
 

CS-8921 
Overlapping Allowed displays wrong 

value in Reports 

Reports / 

Custom Reports 
 

CS-10156 

Error encountered in Report related to 

ServiceBehaviorAttribute or Couldn't 

store <> in Sort0 Column 

Reports / 

Custom Reports 
 

CS-9694 

[Historical Report] Unfriendly error 

when entering an invalid date in the 

initial date field 

Reports / 

Historical 

Reports 

 

CS-8922 

[Scripts] Saving changes on 

References tab will result to 'String or 

binary data would be truncated' error 

Scripts / Details  

CS-4221 

ComponentServices: Invoking 

GetComponentAttributeValueByAttribut

eName throws 

System.ArgumentNullException: Value 

cannot be null. 

SOAP API 30626 
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CS-4219 

[CSWebAPI] 

ReportServices.GetHistoricalReportDat

aByNearestTimeStampAndParent does 

not work 

SOAP API  

CS-4218 

[CSWebAPI] 

ReportServices.GetHistoricalReportDat

aByNearestTimeStamp does not work  

SOAP API  

CS-4217 

[CSWebAPI] 

ReportServices.GetHistoricalReportDat

aByComponent not working 

SOAP API  

CS-4216 

[CSWebAPI] 

ReportServices.GetHistoricalReportDat

a not working  

SOAP API  

CS-4207 

[WebAPI] 

ReportServices.GetReportAttributes 

shows an error 

SOAP API  

CS-4205 
[WebAPI] ReportServices methods that 

do not return data in 912 
SOAP API  

CS-8088 

TryUpdateComponentAttributeValueBy

ComponentID Null value for Space 

Attribute does not log History 

SOAP API 29699 

CS-9593 
ComponentServices.RenameComponen

t doesnâ€™t rename subcomponents 
SOAP API 30696 

CS-10184 

SnmpServices methods that have 

default component as "AllSpaces" when 

invoked 

SOAP API  

CS-10183 

CSWEBAPI SnmpServices methods that 

are showing error when invoked 

because they are missing component 

parameter 

SOAP API  

CS-6160 

[WebAPI] ReportServices: 

GetUserReport gets a 

System.NullReferenceException error 

SOAP API  

CS-10197 

It's possible to save invalid numeric 

component attribute value via the 

SOAP API 

SOAP API  

CS-9138 

[Templates] Default date value is not 

propagating on the existing 

components of that Template 

Templates / 

Attributes 
 

CS-9950 

Moving a template group Cables into a 

new template group causes a loading 

issue when creating connections.  

Templates / 

Attributes 
31019 

CS-10235 

[Templates] Setting a Template default 

value simultaneously with [Today] 

value does not propagate to existing 

components 

Templates / 

Attributes 
 

CS-10219 

[Templates] Inconsistent date-type 

attribute values in Template_Attrib 

table when adding vs updating 

Templates / 

Attributes 
 

CS-10088 

Error logged in console when searching 

for a template in Admin -> 

Configuration -> Templates -> Other 

Templates 

Templates / 

Search 
 

CS-10025 

Lookup for selecting templates does 

not select nodes on search (some 

broken, some working) 

Templates / 

Search 
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CS-10070 
CS context links do not have a dotted 

underline on any iOS browsers 
User Interface  

CS-9625 
Unintended horizontal scrollbar in some 

pages 
User Interface  

CS-7944 

Fix CsWeb client code that relies on 

RegExp without escaping special 

characters 

User Interface  

CS-8934 
Some special characters show as HTML 

character codes on some notifications 
User Interface  

CS-9814 

[Users and Roles] Unnecessary 

horizontal scroll bar in the Permissions 

tab 

User Interface  

CS-9914 

[Zones] 'Add Zone' button is still 

enabled when the Details tab is in Edit 

mode 

User 

Management / 

Zones 

 

CS-10177 

[Zones] Deleting a zone while it's being 

edited then navigating away prompts a 

data-loss confirmation 

User 

Management / 

Zones 

 

CS-9865 

[User Settings] Default Dashboard 

becomes blank after deleting the 

configured dashboard  

User Profile  

CS-10041 
Workflow Settings panels resizing on 

cancel edit 
Workflow  

CS-9031 

Order can be completed even if some 

Tasks are not canceled nor completed 

yet.  

Workflow  

CS-4759 

Workflow: Mark Installed Button still 

grayed out, after device was removed 

from Destination Location.  

Workflow  

CS-10117 
[Workflow] Current Location not being 

updated after moving the component 
Workflow  

CS-10087 
Workflow filter remembers first-used 

value for entire session 
Workflow  

CS-10195 

Workflow tab Move dialog changes 

attribute without logging to history if a 

workflow exception occurs 

Workflow  

CS-10068 

[Workflow] Rack/Location lookup will 

not show the tree, unless the Data 

Center is saved 

Workflow  

CS-10105 

[Workflow] Rack/Location lookup don't 

show the tree if the DataCenter is 

changed to empty 

Workflow  

CS-10166 

[WF] Mark Installed button is not 

greyed out when you create a device in 

the destination Rack/Location 

Workflow  

CS-10145 
Unable to complete an Order with 

multiple tasks Canceled or Draft 
Workflow  

CS-10129 
Reserved port display bug when 

provisioning port connection in WF 
Workflow 31219 

CS-10125 Undoing a patch not working Workflow  

CS-10118 
Workflow: Loading of edit provision is 

slow using Customer DB 
Workflow 31139 

CS-9341 
[Workflow] Setting 'Today' as default 

value of Date Fields attributes shows 
Workflow  
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as '1/1/2001' on Task Details tab 

CS-9152 

[Workflow] Filter's date format doesn't 

persist after refresh, value becomes 

'invalid date' after the second refresh 

Workflow  

CS-9337 

[Asset Workflow] Saving an invalid 

date in the Workflow module will cause 

an error in the Asset Workflow 

Workflow  

 

11.11 List of Bugs Resolved in 12.0.1 

Item Key Summary 
Cormant 

Component 

Customer 

Case 

Number 

CS-10111 

Upgrade script refers to IsHydra and 

causes issues 

Database 

Wizard  

CS-10112 

Create a new build package that 

includes new CormantCS DB's and 

DBUpgradeSchema SQL script Install Package  

CS-10113 Change OSS to IsHydra issue 

Offline Sync 

Service  
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11.12 List of Enhancements in 12.0.0 

Item 

Key 
Summary 

Cormant 

Component 

Customer 

Case 

Number 

    

CS-8704 

[Album] Create a new Album 

Attribute Group to hold specific 

attributes for Albums Albums  

CS-8707 

[Albums Admin] Implement the basic UI 

Layout for the new Album module Albums  

CS-8708 

[Albums Admin] Add ability to filter and 

search albums Albums  

CS-8709 

[Album] Add ability to see album 

attribute values Albums  

CS-8711 [Album] Add ability to delete an album Albums  

CS-8712 

[Album] Add ability to link an album to 

another component Albums  

CS-8717 

[Album] Create a new dialog to handle 

the Add File/Link feature Albums  

CS-8718 

[Album] Add ability to find existing 

albums Albums  

CS-8719 

[Album] Add ability to include (attach) a 

new file Albums  

CS-8721 

[Album Permissions] In the Permissions 

tab, include a new row for the Albums 

module Albums  

CS-8723 

Add "Link/Unlink Album" records to 

Assets History Albums  

CS-8725 

[Album Permissions] Implement Album 

Permissions Albums  

CS-8726 

Create a new Album History Table(s) to 

track all changes related to Albums 

similar to Asset History Albums  

CS-8861 

[Config] Create Admin > System 

Settings > Albums page Albums  

CS-8865 

[Album] Add ability to manage Files in 

an Album (display the files, download, 

delete, add button) Albums  

CS-8868 

[Album] Add ability to unlink album from 

a component Albums  

CS-9026 

[Albums Admin] Add Albums Details tab 

to view/update album attribute values of 

selected Albums Albums  

CS-9059 

[Albums Admin] Add ability to unlink 

components from an album Albums  

CS-9065 

[Album] Add ability to link an album to 

another component using Drag & Drop Albums  

CS-9116 

Add content to new Admin>Album 

History tab - similar layout to Asset 

History Albums  

CS-9119 

[Album] Add ability to Delete an album 

when unlinking the last component from Albums  
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that album 

CS-9120 

[Album] Add ability to change the 

Display Name of a File/Link Albums  

CS-9121 [Album] Add ability to delete a File/Link Albums  

CS-9122 

[Album] Add ability to display extra 

information about a file/link when 

hovering-over the icon Albums  

CS-9143 

[Config] Add ability to configure the 

allowed File Extensions Albums  

CS-9190 

[Albums] In the Assets > Albums tab, 

allow the user to upload a file by just 

dropping a file in the Attachments region Albums  

CS-9201 

[Album Permissions] Implement Zone 

Permissions Albums  

CS-9211 

Add button to open device camera and 

take a picture and attach to an album.  Albums  

CS-9235 

[Albums Admin] Add Components tab 

details Albums  

CS-9239 

Search Results Grid Column for the 

number of linked components Albums  

CS-9240 

Add Show Orphans option on Albums 

Search Albums  

CS-9241 

Only Albums that the user has 

component View or greater rights to will 

be shown on the Albums Search Results 

grid Albums  

CS-9278 

Change the Picture / Icon that 

represents an Album according with 

Album Type Color Albums  

CS-9287 

Various UI adjustments to Admin > 

System Settings > Albums > File 

Extensions configuration Albums  

CS-9306 

Ability to take a photo and Add an album 

with the photo in one go.  Albums  

CS-9307 Open files in a new tab Albums  

CS-9308 

Admin Albums Search Results should be 

exportable to PDF/XLS/CSV Albums  

CS-9320 

Display Albums in the order of the Color 

Type  Albums  

CS-9321 

Album templates need to use Icons and 

colors based on Type  Albums  

CS-9401 

Limit album file selection to allowed 

extensions Albums  

CS-9545 

Add ability to use Quick Search on 

Albums Module Albums  

CS-9612 

Always-visible drag/drop area in Album 

attachments Albums  

CS-9657 

Add ability to remember decision when 

confirming album file upload via 

drag/drop Albums  
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CS-6688 

Add a way to display the Channel Details 

of a connection in CS Web Connection 

Module 

Assets / 

Connections 27936 

CS-8829 

Channel View User will be able to add 

Columns to the Channel View layout 

Assets / 

Connections  

CS-8830 

Channel View Users will be able to define 

which columns to display in the channel 

View via an options dialog 

Assets / 

Connections  

CS-9280 

[Channel Details View] Display the view 

as a Basic Table (all data displayed in 

different cells and rows) 

Assets / 

Connections  

CS-9281 

[Channel Details View] Add ability to 

display imagens and icons on the table-

grid 

Assets / 

Connections  

CS-9348 

On Connections tab, change how 

connection tab buttons behave for the 

new Channel Details View 

Assets / 

Connections  

CS-9411 

Add attributes units to Channel View 

attribute values 

Assets / 

Connections  

CS-9487 Channel Details View - XLS export 

Assets / 

Connections  

CS-9488 Channel Details View - PDF export 

Assets / 

Connections  

CS-9490 

Channel Details View - Add a CS 

hyperlink to the items in the Port / Cable 

column 

Assets / 

Connections  

CS-9494 

Channel Details View - All Components in 

details grids should be Hyper linkable 

Assets / 

Connections  

CS-9702 

Add hyperlinks to exported XLS on 

Channel Details View 

Assets / 

Connections  

CS-8957 

Add CS ID to hover over Cursor text on 

asset Details screens Assets / Details  

CS-9600 

Remove the dots / data points from the 

historical reports in assets module and 

reports module.  

Assets / 

Historical Report  

CS-9403 

Investigate speed of Plan View, Fix if 

possible Create cases if longer time is 

required 

Assets / Plan 

View  

CS-9455 

Keep Plan View tab in memory when 

navigating back and forth the tab 

Assets / Plan 

View  

CS-9456 

Re-use same Plan View data when 

opening the tab on another panel 

Assets / Plan 

View  

CS-9457 

Improve responsiveness of Plan View by 

offloading part of the processing to 

separate threads 

Assets / Plan 

View  

CS-9458 

Show loading spinner when entering or 

leaving Edit Mode in Plan View 

Assets / Plan 

View  

CS-9459 

Do not show rack equipment of nested 

plans in Plan View 

Assets / Plan 

View  

CS-9799 

Rack View options dialog for Device 

Attributes should be Add/Remove 

Attribute(s) 

Assets / Rack 

View  

CS-9326 

Attributes and Templates UX when 

changing contexts / tabs Configuration  
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CS-9728 

Move Custom WF Attributes to 

Component Context 

Configuration / 

Attributes  

CS-9729 

Enforce the Rules for Component 

Context attributes 

Configuration / 

Attributes  

CS-9730 

Enforce the Rules for Workflow Context 

attributes 

Configuration / 

Attributes  

CS-9731 

Enforce the Rules for Album Context 

attributes 

Configuration / 

Attributes  

CS-8845 

[Templates] In the Templates Config, 

change the UI to display system-defined 

Templates separately of component 

templates  

Configuration / 

Templates  

CS-9167 

Disable some template tabs based on the 

template context 

Configuration / 

Templates  

CS-9322 

Workflow Templates that have one or 

more Tasks should not be deleted  

Configuration / 

Templates  

CS-9323 

Disable Export/Import for Album & WF 

templates. 

Configuration / 

Templates  

CS-9539 

Add ability to use Quick Search on 

Constraints Configuration page Constraints  

CS-9961 In the DB Wizard > Configure Database 

section, include a new option to set up 

FileStream 

Database 

Wizard 

 

CS-9389 

[Dashboard] Change the minimum 

sample size from 2 to 25 Dashboard  

CS-8791 

Importing [BLANK] value on Date data 

types fails 

Imports 

(Templates / 

Attributes) 30165 

CS-9543 

Add ability to use Quick Search on 

Network Discovery Locations page 

Network 

Discovery / ND 

Locations  

CS-3073 

Add the attribute 'Type' as part of the 

attributes selection when doing reports 

Reports / 

Custom Reports 

25807, 

26049, 

27944 

CS-5846 Allow Template Type as filter in report Reports / 

Custom Reports 

 

CS-9647 

On Custom Reports, the Includes Filter 

Comparison considers only % as the 

wildcard. It should consider * too. 

Reports / 

Custom Reports  

CS-9599 

Historical Reports - Default data set to 

next hour 

Reports / 

Historical 

Reports  

CS-8850 Searching Attributes (using the complete 

name) with Brackets does not display in 

Attributes list in some Modules 

Search 30226 

CS-1033 Improve Quick Search functionality 

Search & 

Filtering  

CS-9030 

When selecting a Album Template, the 

user should be able to use Search input 

field 

Search & 

Filtering  

CS-9526 

In the Template lookup picker, change 

how the Search results are shown 

Search & 

Filtering  

CS-9532 

Add ability to use Quick Search on 

Reports Module 

Search & 

Filtering  



 Cormant-CS 

Cormant-CS Release Notes 60  
 

CS-9533 

On Workflow Module, rename the Quick 

Search placeholder text 

Search & 

Filtering  

CS-9534 

On Audit Module, rename the Quick 

Search placeholder text 

Search & 

Filtering  

CS-9535 

On Template Configuration, improve the 

Quick Search mechanism (use filtered 

tree, and rename the Quick Search 

placeholder text) 

Search & 

Filtering  

CS-9536 

On Attributes Configuration, rename the 

Quick Search placeholder text 

Search & 

Filtering  

CS-9537 

Add ability to use Quick Search on Zones 

Module 

Search & 

Filtering  

CS-9538 

Add ability to use Quick Search on User 

Management Module 

Search & 

Filtering  

CS-9539 

Add ability to use Quick Search on 

Constraints Configuration page 

Search & 

Filtering  

CS-9540 

Add ability to use Quick Search on Saved 

Attributes Configuration page 

Search & 

Filtering  

CS-9541 

Add ability to use Quick Search on User 

Management > Security page 

Search & 

Filtering  

CS-9542 

Add ability to use Quick Search on 

Scripts Configuration page 

Search & 

Filtering  

CS-9543 

Add ability to use Quick Search on 

Network Discovery Locations page 

Search & 

Filtering  

CS-9635 

In the Attributes dialog picker, there're 

no notification message when there are 

no results found 

Search & 

Filtering  

CS-9636 

In the Quick Search field (from top-bar 

menu), improve the placeholder text so 

that becomes clear that wildcard are 

supported 

Search & 

Filtering  

CS-9644 

On Component Lookup, adjust the 

placeholder text so that becomes clear 

that wildcard are supported 

Search & 

Filtering  

CS-9645 

On Template Lookup, the Search should 

work similar to Attributes Picker 

Search & 

Filtering  

CS-9646 

On Zone Lookup, adjust the placeholder 

text so that becomes clear that wildcard 

are supported 

Search & 

Filtering  

CS-9665 

 In the Search input fields, when hitting 

on X button, it should clear the field and 

perform the search bringing all data 

Search & 

Filtering  

CS-9666 

In the System Settings > Workflow 

Settings tab > New Task Dialog, change 

the Attribute Group lookup to follow 

convention 

Search & 

Filtering  

CS-9667 

In the Component lookup picker, change 

how the Search results are shown (use 

filtered tree) 

Search & 

Filtering  

CS-9697 

On Template Lookup Tree, add a 

context-menu with options to Expand All 

and Collapse All 

Search & 

Filtering  

CS-9699 

Adjust Single-select Attribute pickers to 

be consistent through the application 

Search & 

Filtering  
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CS-9700 

Adjust the Title of the Attribute dialogs 

to be consistent through the application 

Search & 

Filtering  

CS-9701 

Adjust Multi-select Attribute pickers to 

be consistent through the application 

Search & 

Filtering  

CS-9734 

The WF Templates Attribute Picker 

should be altered to only show 

Component Context attributes 

Search & 

Filtering  

CS-9735 

The WF Settings Attribute Picker should 

be altered to only show Component 

Context attributes 

Search & 

Filtering  

CS-9752 Add filtered search to Zone lookup 

Search & 

Filtering  

CS-9753 

Add filtered search to Single Value 

Lookup dialogs (used in multiple places 

picking a component) 

Search & 

Filtering  

CS-9754 

Add filtered search to component 

lookups in Workflow 

Search & 

Filtering  

CS-9755 

Add filtered search to Port and Cable 

lookups 

Search & 

Filtering  

CS-9274 

Update SOAP API docs for template 

refactoring work. SOAP API  

CS-9733 

Check the following SOAP Endpoints and 

ensure they only work with Component 

Context Attributes SOAP API  

 

11.13 List of Bugs Resolved in 12.0.0 

Item 

Key 
Summary 

Cormant 

Component 

Customer 

Case 

Number 

CS-8987 

Restriction when deleting a space in HH 

[Android] where there is a planned Task Android / Sync  

CS-4142 

Editing the space of a component on 

Assets details tab doesn't update the 

breadcrumbs Assets / Details  

CS-9163 

Workflow templates appear in component 

template lookup dialogs Assets / Details  

CS-9290 

Double vertical scroll bar on the 

Template and Space lookup window Assets / Details  

CS-9302 

Validation missing and error encountered 

when Template is not set when adding a 

component or multiple components Assets / Details  

CS-9431 

There's a JS error when trying to Add 

new Component Assets / Details  

CS-9477 

In Asset > Details, JS error when trying 

to change the Space field of DC1-

CRAC01 to DC1-ROW1 Assets / Details  

CS-9481 

[Assets] Console error when adding a 

single component  Assets / Details  

CS-9748 

Buttons in Assign Barcode dialog have 

weird offset on small screen Assets / Details  

CS-9826 

After renaming a component, any 

succeeding save in attributes of the same 

component will keep displaying the Assets / Details  



 Cormant-CS 

Cormant-CS Release Notes 62  
 

rename dialog 

CS-9830 

Renaming a component on Assets details 

tab doesn't update the breadcrumbs Assets / Details  

CS-9833 

Incorrect and unnecessary validation on 

the Space field when adding multiple 

components Assets / Details  

CS-9848 

On Assets, the user can't add/delete a 

component due to a wrong "permission" 

rule when using the corresponding 

keyboard shortcut Assets / Details  

CS-9146 

In Assets Historical Reports, make the 

chart fit in the page  

Assets / 

Historical Report  

CS-5708 

[Move Here] JS error with "No 

component found" shows in the console 

when a new barcode is entered on the 

Search field 

Assets / Move 

Here  

CS-8324 

Some components cause the 

confirmation dialog to be shown when 

Plan View is in edit mode, whereas other 

components in the same level of the 

hierarchy don't 

Assets / Plan 

View  

CS-8995 

[Assets] Console error when moving 

components while Planview tab is the 

active tab 

Assets / Plan 

View  

CS-9043 

[Planview] Console error when clicking 

Edit and Save on plan view while the left 

panel is on Search tab. 

Assets / Plan 

View  

CS-9335 

[Plan View] Console error when copying 

some component's vertices using "Make 

Same As" 

Assets / Plan 

View  

CS-9387 

[Assets] Console error when pressing the 

'Escape' button from keyboard while Plan 

view is the active tab 

Assets / Plan 

View  

CS-9437 

Rack front cannot be unset if the 

template has a front defined 

Assets / Plan 

View  

CS-9460 

Zoom is incorrect when resetting/loading 

a large plan on Plan View tab 

Assets / Plan 

View  

CS-9470 

Rack does not move back to original 

position when cancelling edit if Save 

Template functionality is used 

Assets / Plan 

View  

CS-9471 

Template vertices are not updated and 

rack is moved to weird position when 

using Save Template functionality on an 

unchanged rack 

Assets / Plan 

View  

CS-9473 

Unpositioned components do not use 

default front vertices defined on 

Template 

Assets / Plan 

View  

CS-9496 

Shortcut key for editing plan view not 

working 

Assets / Plan 

View  

CS-9548 

Plan View throws error in console when 

renaming the same component twice 

Assets / Plan 

View  

CS-9615 

Plan View loads data twice in the back-

end when saving the plan 

Assets / Plan 

View  
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CS-9822 

Plan View rack equipment images are 

inverted 

Assets / Plan 

View  

CS-9836 

[Planview] 'Index out of range' error 

when re-uploading a Planview image  

Assets / Plan 

View  

CS-9847 

[Planview] Saving a floor plan after 

clicking OK on the data loss warning 

generates a console error 

Assets / Plan 

View  

CS-9903 

Unable to save changes for icons in Plan 

View and they are inverted when 

dragged 

Assets / Plan-

view  

CS-8014 

[Rack View] Clicking Edit mode when it is 

disabled will show 'It's not possible to 

edit 2 panels at the same time.' even 

though the split screen is not enabled 

Assets / Rack 

View  

CS-8069 

In the Rack View, a confirmation dialog 

appears warning about data-loss even 

when selecting an equipment from the 

current rack 

Assets / Rack 

View  

CS-8697 

[Permission] Console error encountered 

when user without permission "Add 

Component" in Rack View 

Assets / Rack 

View  

CS-9550 

Copying a row unracks devices and 

causes them to lose their U location. 

Assets / Rack 

View 30605 

CS-9654 

On Assets -> Rack View -> Display 

Options dialog, adding a new attribute 

should include it at the end of the list, 

not in alpha order 

Assets / Rack 

View  

CS-9655 

On Assets -> Rack View -> Display 

Options dialog, adding/removing an 

attribute after a reorder doesn't update 

the list 

Assets / Rack 

View  

CS-9656 

On Assets -> Rack View -> Display 

Options dialog, cancelling the delete 

attribute dialog after a reorder doesn't 

persist the order changes 

Assets / Rack 

View  

CS-9844 

All attributes shown on Delete attributes 

dialog for Print options of Rack View 

when there are no attributes to be used 

as page headers 

Assets / Rack 

View  

CS-8637 

Action buttons are in the wrong state 

after switching to a different Saved filter 

while in Edit mode Assets / Search  

CS-9139 

[Search] Searching with invalid date on 

the date fields will get stuck on a loading 

state and an unfriendly error when 

saving it. Assets / Search  

CS-9170 

[Search] Searching while user is in Edit 

mode will make a JS error occur Assets / Search  

CS-8982 

Issues after renaming components via 

the Search Results tab 

Assets / Search 

Results  

CS-9696 

Assets Tree component names are not 

updated when components are renamed 

in Search Results tab 

Assets / Search 

Results  

CS-9277 

Asset-Subcomponents Deleting mass 

components is very slow or fails 

Assets / 

Subcomponents  
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CS-9838 

Error 'No Such Host is Known' when 

running Query Device of an asset in 

Asset tree. Assets / Tree 28127 

CS-9872 

[Assets Tree] Using the 'F2' shortcut, 

users can put the node in edit mode even 

when the edit is not allowed Assets / Tree  

CS-8524 

Console error when clicking on Move 

button in Assets Worfklow for users with 

View-only permission to Workflow 

Assets / 

Workflow  

CS-8651 

[Asset-WF] Inconsistent display of data-

loss warning when editing the Task Flags 

Assets / 

Workflow  

CS-9864 

[Assets] Clicking a component after 

accessing an unpermitted tab generates 

a console error 

Assets / 

Workflow  

CS-9821 

Barcode scanner uses wrong device 

camera 

Barcode 

Scanning  

CS-9397 

In the Configuration > Attributes, in the 

lookup of the "Attribute to Calculate" 

field, a JS error occurs when attribute 

group is selected 

Configuration / 

Attributes  

CS-9662 

[Attribute Configuration] Console error 

when clicking the 'OK' button without 

clicking any attribute group 

Configuration / 

Attributes  

CS-9671 

[Attribute Config] Current attribute 

Group node not being selected when 

opening Attribute Group dialog 

Configuration / 

Attributes  

CS-9850 

Rack Unit Height rack attribute cannot be 

calculated when used as Calculated 

Attribute 

Configuration / 

Attributes 30939 

CS-9943 

[Attributes] Unable to set Selection-type 

attributes to Required 

Configuration / 

Attributes  

CS-9247 

Incorrect number of components 

specified when changing template 

attribute value 

Configuration / 

Templates  

CS-9248 

Admin -> Configuration -> Templates -> 

Remove Attributes dialog not working for 

some attributes 

Configuration / 

Templates  

CS-9344 

[Template] When moving a template to 

another parent, the Template field 

(parent) is not updated on the page 

Configuration / 

Templates  

CS-9406 

In the new Attribute Lookup Dialog, 

when displaying Context Type dropdown 

there are two scrollbars   

Configuration / 

Templates  

CS-9438 

[Templates] Console error encountered 

when Add Template or CTRL+I is clicked 

by user with View Only permission 

Configuration / 

Templates  

CS-9556 

On Template Details, the "Connected 

Icon" attribute is not being displayed in 

the correct order 

Configuration / 

Templates  

CS-9672 

No config history log when renaming a 

Template via context menu 

Configuration / 

Templates  

CS-9790 

[Template] When exporting a template 

subcomponent, the subcomponent name 

column is blank  

Configuration / 

Templates  

CS-8695 

[Dashboard] Issues when the report 

used by a widget is deleted in Reports Dashboard  
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tab 

CS-9118 

[Dashboard] Inconsistent behavior when 

the Date Range Fields on widgets are 

empty or with invalid data Dashboard  

CS-9213 

Meter widget in dashboard is not 

displayed properly Dashboard  

CS-9691 

[Dashboard Widget] When creating a 

new Custom Report Widget, the title is 

not persisted in the database properly Dashboard  

CS-8531 

[Historical Report] Clicking the Export 

and Print button when there is no 

selected report generates console error Historical Report  

CS-9572 

[Import] Deleting mass components is 

very slow or fails Imports  

CS-9812 

[Import] Line References in the Import 

Errors are 1 line off when the file is in 

.xls/.xlsx format Imports  

CS-9942 

[Import] Unable to import connections 

using Excel format Imports  

CS-9947 

[Logs] Setting 'Today' as value for Date 

attributes under Templates tab shows as 

'1/1/1' on the Configuration History Logs  

CS-9220 

In the Logs > Administration History, 

some Permission Level descriptions 

donâ€™t match the displayed text from 

the Admin > Users & Roles > 

Permissions tab 

Logs / 

Administration 

History  

CS-5316 

Script Logs need to be limited to a 

handle-able number of entries to display 

Logs / 

Configuration 

History  

CS-9293 

Changes to Config/Saved Attributes are 

not saved to Config History 

Logs / 

Configuration 

History  

CS-9553 

On Configuration History, a JS error 

occurs when trying to Export to PDF, XLS 

or CSV 

Logs / 

Configuration 

History  

CS-9732 

[Logs] Setting 'Today' as default value 

for Date-type attributes shows as '1/1/1' 

on the Configuration History 

Logs / 

Configuration 

History  

CS-4933 

Console error when choosing Asset as an 

attribute in Discovery Attribute Mapping 

Network 

Discovery  

CS-9309 

JS error encountered when opening 

attribute lookup in Reference Data Reference Data  

CS-9439 Ability to search a report in the report 

module 

Reports 30511 

CS-9721 

 Exporting files in XLS format is not 

working with History related reports 

Reports / 

Historical 

Reports  

CS-7546 

[SwaggerUI] Error shown in the POST 

request on Attributes endpoint RESTAPI  

CS-9445 

On Rest API, an Object Reference error is 

shown when creating an OfflineSync 

Conflict with an OfflineSync Profile that 

does not exist RESTAPI  
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CS-9740 

'All Spaces' shows as '0' on the Add 

Component dialog when using the 

Create/Assign Barcode dialog Scan & Assign  

CS-9748 

Buttons in Assign Barcode dialog have 

weird offset on small screen Scan & Assign  

CS-9668 

When Modified scripts are run multiple 

times on the same rack when deleting its 

children 

Scripting 

Service  

CS-9747 

Quick search does not work after 

repeating a search after a clear 

Search & 

Filtering  

CS-9797 

Search loop behavior in Templates 

Search 

Search & 

Filtering  

CS-9871 

Components of type Area are not shown 

on lookups that should include that type 

of component 

Search & 

Filtering  

CS-7604 

User is redirected to a blank page after 

setting up a new password Security / Login  

CS-7710 

Blank page displayed after logging in for 

first time Security / Login  

CS-8936 

[Workflow Settings] Clicking 'Cancel' on 

the data loss warning will allow no email 

status selected, causes console error 

when saving on other tabs 

Settings / 

Workflow  

CS-9048 

[Workflow Settings] Console error when 

clicking the 'OK' button without clicking 

any attribute group 

Settings / 

Workflow  

CS-9736 

[UI] Put a good amount of space 

between checkbox and label in Enable 

Status Change Emails 

System Settings 

/ General  

CS-9800 

[User Management] Admin dropdown 

options in Permissions tabs and in Zones 

tab are different 

User 

Management / 

User and Roles  

CS-9839 

In the Create User dialog, a JS error if 

the user selects the Blank option in the 

Role field 

User 

Management / 

User and Roles  

CS-4802 

[User] At first login of user, doesn't fully 

load the homepage 

User 

Management / 

Users and Roles  

CS-5785 

[Permission] User with View only 

permission can invoke the Add 

Component dialog via ctrl+I 

User 

Management / 

Users and Roles  

CS-9594 

Error when trying to update module 

permissions for the Customer role  

User 

Management / 

Users and Roles  

CS-9737 

After hitting Apply Filter, the action 

buttons remain enabled even if there's 

no selected user 

User 

Management / 

Users and Roles  

CS-9803 

[User and Roles] Console error when 

selecting the blank option for the Role 

when creating a new user 

User 

Management / 

Users and Roles  

CS-6533 

[Workflow Attachment] No validation 

message when trying to add a 

Attachment without an attached file Workflow  

CS-7754 

Error after selecting a component without 

a site on On WF > Add New Task Workflow  
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CS-6287 

[Workflow] Device Details tab stuck in 

loading state when a user with View 

permission tries to open the task 

Workflow / 

Device Details  

CS-8539 

[Workflow] Device Details is stuck in 

loading state when the destination 

location set is deleted from the Asset 

tree 

Workflow / 

Device Details  

CS-8976 

Console error encountered when clicking 

the down arrow key after the end of the 

port sequence in Provisioning details 

Workflow / 

Provisioning  

CS-9682 Unable to create an Admin Task 

Workflow 

Manager  

CS-9683 

Error encountered when creating a task 

to a component with duplicate slot 

number 

Workflow 

Manager  

 

 

 


